# Table of Contents

## 1 Using the machine as a printer

Using the Brother printer driver ................................................................. 1-1
How to print your document .................................................................. 1-1
  - Printing from the manual feed slot .................................................. 1-2
  - Manual Duplex Printing ................................................................ 1-3
Simultaneous printing and faxing ......................................................... 1-3
Printer operation key ............................................................................. 1-3
  - Job Cancel ..................................................................................... 1-3
  - Popular Printer Emulation Support (MFC-7225N and MFC-7820N only) .......................................................... 1-4
  - Printing the Internal Font List ....................................................... 1-4
  - Printing the Print Configuration List ............................................ 1-5
  - Restoring default settings ............................................................ 1-5
Printer driver settings (For Windows®) ............................................... 1-6
  - How to access the printer driver settings (For Windows®) .......... 1-6
Features in the PCL printer driver (For Windows®) ......................... 1-7
  - Basic tab ..................................................................................... 1-7
  - Advanced tab .............................................................................. 1-9
  - Print Quality .............................................................................. 1-10
  - Duplex ....................................................................................... 1-11
  - Watermark ............................................................................... 1-12
  - Page Setting .............................................................................. 1-13
  - Device Options ......................................................................... 1-13
  - Support tab ............................................................................... 1-17
Features in the PS (PostScript®) Brother printer driver
  (MFC-7225N and MFC-7820N only) (For Windows®) ..................... 1-18
  - Ports tab .................................................................................... 1-18
  - Layout tab ................................................................................ 1-19
  - Paper / Quality tab .................................................................... 1-19
  - Advanced Options ..................................................................... 1-19
Status Monitor (Windows® only) ....................................................... 1-20
  - How to turn on the status monitor ............................................ 1-20
  - Monitoring and viewing the machine’s status ......................... 1-20

## 2 How to scan using Windows®

Scanning a document using WIA driver (For Windows® XP only) .... 2-2
  - WIA compliant .......................................................................... 2-2
  - How to access the scanner ......................................................... 2-2
Scanning a document into the PC (For MFC-7220 and MFC-7225N) 2-3
Scanning a document into the PC
  (DCP-7020, MFC-7420 and MFC-7820N Only) ............................. 2-4
Scanning a document using the TWAIN driver ......................... 2-7
TWAIN compliant ........................................................................................................2-7
How to access the Scanner........................................................................................2-7
Scanning a document into the PC ............................................................................2-8
Settings in the Scanner window ..............................................................................2-10
Using the Scan key (For USB or Parallel cable users) ................................................2-13
Scan to E-mail ...........................................................................................................2-13
Scan to Image ............................................................................................................2-14
Scan to OCR .............................................................................................................2-14
Scan to File ...............................................................................................................2-14
Using ScanSoft® PaperPort® 9.0SE and OmniPage® OCR ..................................2-15
Viewing items ..........................................................................................................2-16
Organizing your items in folders ............................................................................2-16
Quick links to other applications ...........................................................................2-17
ScanSoft® OmniPage® OCR lets you convert image text into text you can edit ....2-17
Importing items from other applications ...............................................................2-17
Exporting items in other formats ..........................................................................2-18
How to Uninstall PaperPort® 9.0SE and ScanSoft® OmniPage® OCR ...............2-18

3 Using ControlCenter2.0 (For Windows®)

ControlCenter2.0 ........................................................................................................3-1
How to turn off the AutoLoad feature in ControlCenter2.0 ...................................3-2
SCAN .........................................................................................................................3-2
CUSTOM SCAN ........................................................................................................3-2
COPY .........................................................................................................................3-3
PC-FAX (not available for DCP-7020) ....................................................................3-3
DEVICE SETTING (not available for DCP-7020) ..................................................3-3
SCAN .........................................................................................................................3-4
Image (example: Microsoft Paint) ..........................................................................3-4
OCR (Word Processing program) ...........................................................................3-5
E-mail .........................................................................................................................3-5
File attachments ........................................................................................................3-6
File ...............................................................................................................................3-6
CUSTOM SCAN ........................................................................................................3-7
Customizing a user-defined button .........................................................................3-8
COPY .........................................................................................................................3-11
PC-FAX (not available for DCP-7020) ....................................................................3-12
Send ..........................................................................................................................3-12
Receive / View Received ..........................................................................................3-12
Address Book ...........................................................................................................3-13
Setup ..........................................................................................................................3-13
DEVICE SETTING (not available for DCP-7020) ..................................................3-14
Remote Setup ..........................................................................................................3-14
Quick-Dial ................................................................................................................3-14
4 Using MFC Remote Setup (For Windows®)
   (not available for DCP-7020)

   MFC Remote Setup................................................................. 4-1

5 Using Brother PC-FAX software (For Windows®)
   (not available for DCP-7020)

   PC-FAX sending................................................................. 5-1
   Setting up user information ........................................... 5-1
   Sending setup ................................................................. 5-2
   User interface ................................................................. 5-3
   Address Book ................................................................. 5-4
   Setting up a Cover Page .................................................. 5-5
   Entering Cover Page Information ..................................... 5-5
   Speed-Dial setup .............................................................. 5-6
   Brother Address Book ..................................................... 5-6
   Setting up a Member in the Address Book ...................... 5-7
   Setting up a Group for Broadcasting ......................... 5-7
   Editing Member information .......................................... 5-7
   Deleting a Member or Group .......................................... 5-8
   Exporting the Address Book ........................................... 5-8
   Importing to the Address Book ....................................... 5-9
   Sending a file as a PC-FAX using the Facsimile style user interface 5-10
   Sending a file as a PC-FAX using the Simple style user interface 5-11
   Setting up PC-FAX receiving ........................................... 5-12
   Running PC-FAX Receiving ............................................. 5-12
   Setting up your PC .......................................................... 5-12
   Viewing new PC-FAX messages ...................................... 5-13

6 Network Scanning (For Windows®)
   (MFC-7225N, MFC-7820N or models with the optional NC-2200w Only)

   Network License ............................................................... 6-1
   Registering your PC with the machine for scanning .......... 6-1
   Using the Scan key .......................................................... 6-3
   Scan to E-mail ................................................................. 6-3
   Scan to Image ................................................................. 6-4
   Scan to OCR ................................................................. 6-5
   Scan to File ................................................................. 6-6
# Using your machine with a Macintosh®

| Setting up your USB-equipped Apple® Macintosh® | 7-1 |
| Using the Brother printer driver with your Apple® Macintosh® (Mac OS® X) | 7-2 |
| Choosing page setup options | 7-2 |
| Specific settings | 7-3 |
| Using the Brother printer driver with your Apple® Macintosh® (Mac OS® 9.1 to 9.2) | 7-4 |
| Using the PS driver with your Apple® Macintosh® (MFC-7225N and MFC-7820N only) | 7-5 |
| For Mac OS® X users | 7-5 |
| For Mac OS® 9.1 to 9.2 users | 7-7 |
| Sending a fax from your Macintosh® application (not available for DCP-7020) | 7-9 |
| For Mac OS® X users | 7-9 |
| Drag a vCard from the Mac OS® X Address Book application | 7-11 |
| For Mac OS® 9.1 to 9.2 users | 7-12 |
| Scanning from a Macintosh® | 7-13 |
| Accessing the scanner | 7-13 |
| Scanning an image into your Macintosh® | 7-14 |
| Pre-Scanning an image | 7-15 |
| Settings in the Scanner window | 7-16 |
| Configuring Network Scanning | 7-19 |
| Using Presto!® PageManager® | 7-21 |
| Highlights | 7-21 |
| System requirements for Presto!® PageManager® | 7-21 |
| Technical Support | 7-22 |
| Using ControlCenter2.0 (For Mac OS® X 10.2.4 or greater) | 7-24 |
| How to turn off the AutoLoad feature in ControlCenter2.0 | 7-24 |
| SCAN | 7-25 |
| CUSTOM SCAN | 7-25 |
| COPY | 7-25 |
| DEVICE SETTINGS (not available for DCP-7020) | 7-26 |
| SCAN | 7-26 |
| CUSTOM SCAN | 7-29 |
| COPY | 7-34 |
| DEVICE SETTINGS (not available for DCP-7020) | 7-35 |
| MFC Remote Setup (Mac OS® X 10.2.4 or greater) (not available for DCP-7020) | 7-36 |

## Index

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-1</td>
</tr>
</tbody>
</table>
Using the Brother printer driver

A Printer Driver is software that translates data from the format used by a computer into the format required by a particular printer, using a printer command language or page description language.

The printer drivers are on the CD-ROM we have supplied. Install the drivers first by following the Quick Setup Guide. Also, the latest printer driver can be downloaded from the Brother Solutions Center at:

http://solutions.brother.com

Windows® Printing

The dedicated printer driver for Microsoft® Windows® 98/98SE/Me/2000 Professional/XP and Windows NT® workstation 4.0 are available on the CD-ROM supplied with your Brother device. You can install them easily into your Windows® system using our installer program. The driver supports our unique compression mode to enhance printing speed in Windows® applications, and allows you to set various printer settings, including economy printing mode and custom paper size.

How to print your document

When the machine receives data from your computer, it begins printing by picking up paper from the paper tray. The paper tray can feed many types of paper and envelopes. (See the User’s Guide for information about the Paper Tray and Recommended paper.)

1. From your application, select the Print command.
   
   If any other printer drivers are installed on your computer, select Brother MFC-XXXX or DCP-XXXX (USB) Printer (Where XXXX is your model name. If you are using a USB cable to connect your machine then USB will be in the printer driver name) as your printer driver from the Print or Print Settings menu in your software application, and then click OK to begin printing.

   **Note**

   For Macintosh® users, see Using the Brother printer driver with your Apple® Macintosh® (Mac OS® X) on page 7-2 or Using the Brother printer driver with your Apple® Macintosh® (Mac OS® 9.1 to 9.2) on page 7-4.

2. Your computer sends the data to the machine.
   
   The LCD shows Receiving Data.

3. When the machine finishes printing all the data, the LCD shows the date and time.

   **Note**

   You can select the paper size and orientation in your application software.

   If your application software does not support your custom paper size, select the next larger paper size. Then adjust the print area by changing the right and left margins in your application software.
Printing from the manual feed slot

Note
- The machine automatically turns on the Manual Feed mode when you put paper in the manual feed slot.
- The machine illustrations are of the MFC-7420 or MFC-7820N, but the descriptions apply to all the models.

1 Set the **Paper Size**, **Media Type**, **Paper Source**, and other settings in the printer driver.
   Set the **Paper Source** to **Manual**.

2 Slide the paper guides to fit the paper size.

3 Using both hands put paper in the manual feed slot until the front edge of the paper touches the paper feed roller. Hold the paper in this position until the printer automatically feeds it in for a short distance, and then let go of it.

4 Send the print data to the machine.

Note
- Put the paper into the manual feed slot with the side to be printed face up.
- Make sure that the paper is straight and in the proper position on the manual feed slot. If it is not, the paper may not be fed properly, resulting in a skewed printout or a paper jam.
- Do not put more than one piece of paper in the manual feed slot at any one time, as it may cause a jam.

5 After the printed page comes out of the machine, put in the next sheet of paper as in Step 3 above. Repeat for each page that you want to print.
Using the machine as a printer

Manual Duplex Printing

The machine prints all the even-numbered pages on one side of the paper first. Then, the Windows® driver instructs you (with a pop-up message) to reinsert the paper. Before reinserting the paper, straighten it well, or you may get a paper jam. Very thin or very thick paper is not recommended.

Simultaneous printing and faxing

Your machine can print from your computer while sending or receiving a fax in memory, or while scanning a document into the computer. Fax sending will not be stopped during PC printing. However, when the machine is copying or receiving a fax on paper, it pauses the PC printing operation, and then continues printing when copying or fax receiving has finished.

Note
The Fax function is not available for DCP-7020.

Printer operation key

Job Cancel

If the LCD shows Data Remaining, you can clear the data that is left in the printer memory by pressing Job Cancel.
Popular Printer Emulation Support (MFC-7225N and MFC-7820N only)

The MFC-7225N and MFC-7820N support HP LaserJet (PCL level 6) and the BR-Script 3 (PostScript® 3™) printer emulation modes. If you use DOS application software, you can use the HP LaserJet (PCL level 6) or BR-Script 3 (PostScript® 3™) emulation mode for printer operations.

Setting the Emulation Selection

Your machine will receive print commands in a printer job language or Emulation. Different operating systems and applications will send the print commands in different languages. Your machine can receive print commands in a variety of emulations. This machine has an Automatic Emulation Selection setting. When the machine receives information from the PC, it automatically chooses the emulation mode. This setting has been set at the factory to AUTO.

You can change the default emulation mode manually by using the control panel.

1. Press Menu/Set, 4, 1.
2. Press ▲ or ▼ to select Auto, HP LaserJet or BR-Script 3. Press Menu/Set.
3. Press Stop/Exit.

Note

We recommend that you set the emulation setting with your application software or network server. If the setting does not work properly, select the required emulation mode manually using the control panel buttons of the machine.

Printing the Internal Font List

You can print a list of the machine’s internal (or resident) fonts to see how each font looks before you select it.

1. Press Menu/Set, 4, 2, 1.
2. Press Start. The machine prints the list.
3. Press Stop/Exit.
Using the machine as a printer

Printing the Print Configuration List

You can print a list of current printer settings.

1. Press Menu/Set, 4, 2, 2.
2. Press Start. The machine prints the settings.
3. Press Stop/Exit.

Restoring default settings

You can return the machine to the default settings. Fonts and macros in the temporary settings are cleared.

1. Press Menu/Set, 4, 3.
2. Press 1 to restore the default settings.
   —OR—
3. Press 2 to exit without making a change.
4. Press Stop/Exit.

Note

Only the printer settings will be returned to the default settings.
Using the machine as a printer

Printer driver settings (For Windows®)

Note
For Macintosh® users, see Using the Brother printer driver with your Apple® Macintosh® (Mac OS® X) on page 7-2 or Using the Brother printer driver with your Apple® Macintosh® (Mac OS® 9.1 to 9.2) on page 7-4.

You can change the following printer settings when you print from your computer:

- Paper Size
- Multiple Page
- Orientation
- Copies
- Media Type
- Paper Source
- Resolution
- Toner Save Mode
- Manual Duplex
- Watermark
- Scaling
- Print Date & Time
- Quick Print Setup
- Status Monitor

*1 These settings are not available with the BR-Script driver.

How to access the printer driver settings (For Windows®)

1. Select Print from the File menu in your application software.

2. Select Brother MFC-XXXX (USB) Printer or Brother DCP-XXXX (USB) Printer (Where XXXX is your model name and if you are connected USB then USB will be in the printer driver name) and click Properties or Preferences. (Document Default for Windows NT® 4.0). The Printer dialog box will appear.

Note
- The way you access the printer driver settings depends on your operating system and software applications.
- The screens shown in this chapter are from Windows® XP. The screens on your computer may vary depending on your Windows® operating system.
Features in the PCL printer driver (For Windows®)

Basic tab

1. Select the **Paper Size**, **Multiple Page**, **Border Line** (if any) and **Orientation**.
2. Select number of **Copies** and **Media Type**.
3. Select the **Paper Source** (**First Page** and **Other Pages**).
4. Click the **OK** button to apply your selected settings.
   To return to the default settings, click the **Default** button, then click the **OK** button.

**Paper Size**
From the drop-down box select the Paper Size you are using.

**Multiple Page**
The Multiple Page selection can reduce the image size of a page allowing multiple pages to be printed on one sheet of paper or enlarging the image size for printing one page on multiple sheets of paper.

Ex. 4 in 1

Ex. 1 in 2 x 2 pages
Using the machine as a printer

**Border Line**
When printing multiple pages on one sheet with the Multiple Page feature you can select to have a solid border, dash border or no border around each page on the sheet.

**Orientation**
Orientation selects the position of how your document will be printed (Portrait or Landscape).

![Portrait](image)
![Landscape](image)

**Copies**
The copies selection sets the number of copies that will be printed.

**Collate**
With the Collate check box selected, one complete copy of your document will be printed and then repeated for the number of copies you selected. If the Collate check box is not selected, then each page will be printed for all the copies selected before the next page of the document is printed.

![Collate checked](image)
![Collate not checked](image)

**Media Type**
You can use the following types of media in your machine. For the best print quality, select the type of media that you wish to use.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparencies</td>
<td>Envelopes</td>
<td>Env. Thick</td>
<td>Env. Thin</td>
<td>Recycled Paper</td>
</tr>
</tbody>
</table>

**Note**
- When you use envelopes, select Envelopes. If the toner is not fixed to the envelope correctly when Envelopes has been selected, select Env. Thick. If the envelope is crumpled when Envelopes has been selected, select Env. Thin.

**Paper Source**
You can choose Auto Select, Tray 1 or Manual and specify separate trays for printing the first page and for printing from the second page onwards.
Advanced tab

Change the tab settings by selecting one of the following icons:

1 Print Quality
2 Duplex
3 Watermark
4 Page Setting
5 Device Options

Note
To return to the default settings, click the Default button.
Using the machine as a printer

Print Quality

Resolution
You can change the resolution as follows:

- HQ 1200 (DCP-7020, MFC-7420, MFC-7820N and MFC-7225N)
- 1200 x 600 (MFC-7220)
- 600 dpi
- 300 dpi

Toner Save Mode
You can save running costs by turning on the Toner Save Mode, which reduces the print density.

Print Setting
You can manually change the Print setting.

- Auto
  Selecting the Auto (Recommended) button will allow automatic printing with the most suitable print settings for your print job.

- Manual
  You can change the settings manually by selecting the Manual button and clicking the Setting... button.
  For Windows® 98/98SE/Me users: Brightness, Contrast and other settings.
Duplex

The PCL printer driver supports manual duplex printing.

**Manual Duplex**

Check **Manual Duplex**. In this mode, the machine prints all the even numbered pages first. Then the printer driver stops and shows the instructions required to re-install the paper. When you click **OK** the odd numbered pages are printed.

**Duplex Type**

There are six types of duplex directions available for each orientation.

- **Flip on Left Edge**
- **Flip on Right Edge**
- **Flip on Top Edge**
- **Flip on Bottom Edge**
- **Flip on Top Edge (No Reverse)**
- **Flip on Bottom Edge (No Reverse)**

**Binding Offset**

Check the Binding Offset option, you can specify the offset value of the binding side in inches or millimeters (0 - 8 inches) [0 - 203.2 mm].
Using the machine as a printer

**Watermark**

You can place a logo or text into your document as a Watermark. You can select one of the preset Watermarks, or you can use a bitmap file or text file that you have created.

Check **Use Watermark**, and then select the watermark you want to use.

**Transparent**

Check **Transparent** with the Watermark to print the watermark image in the background of your document. If this feature is not checked then the Watermark will be printed on top of your document.

**In Outline Text**  
(Windows® 2000/XP/Windows NT® 4.0)

Check **In Outline Text** if you only want to print an outline of the watermark.

**Print Watermark**

The **Print Watermark** feature offers the following print choices:

- **On all pages**
- **On first page only**
- **From second page**
- **Custom**

**Watermark Setting**

You can change the Watermark’s size and position on the page by selecting the Watermark, and clicking the **Edit** button. If you want to add a new Watermark, click the **New** button, and then select **Text** or **Bitmap** in the **Watermark Style**.

- **Title**
  
  You can select the **CONFIDENTIAL**, **COPY** or **DRAFT** as the standard title or enter a title you like in the field.

- **Watermark Text**
  
  Enter your Watermark text into the **Text** Box, and then select the **Font**, **Size**, **Darkness** and **Style**.

- **Watermark Bitmap**
  
  Enter the file name and location of your bitmap image in the **File** box, or **Browse** for the file location. You can also set the scaling size of the image.

- **Position**
  
  Use this setting if you want to control the position of the watermark on the page.
Using the machine as a printer

**Page Setting**

**Scaling**

You can change the print size of your document with the **Scaling** feature.

- **Check Off** if you want to print the document as it appears on your screen.
- **Check Fit to Paper Size** if your document has an unusual size, or if you have only the standard size paper.
- **Check Free** if you want to change the size.

You can also use the **Mirror Print** or **Reverse Print** feature for your page setting.

**Device Options**

You can set the following **Printer Function** modes in this tab:

- **Quick Print Setup**
- **Status Monitor**
- **Macro**
  (MFC-7225N and MFC-7820N only)
- **Administrator** (For Windows® 98/98SE/Me users only)
- **Insert Command/File**
  (For Windows® 98/98SE/Me users only)
  (MFC-7225N and MFC-7820N only)
- **Page Protection**
- **Print Date & Time**
- **Density adjustment**

**Note**

The **Printer Function** list may differ depending on the model.
Quick Print Setup

The Quick Print Setup feature allows you to quickly select driver settings. To view settings, simply click your mouse button on the task tray icon. This feature can be set to On or Off from the Device Options.

Status Monitor

This reports the machine status (any error that may happen with the machine) when printing. The default setting for the Status Monitor is off. If you would like to turn the Status Monitor on, go to the Advanced tab, select Device options and then select Status monitor.

Macro (MFC-7225N and MFC-7820N only)

You can save a page of a document as a macro to the printer memory. Also, you can execute the saved macro - in other words, you can use the saved macro as an overlay on any document. This will save time and increase printing speed for often used information such as forms, company logos, letterhead formats or invoices. For more information, please see the Help text in the printer driver.
Using the machine as a printer

Administrator (For Windows® 98/98SE/Me Users Only)
The administrator selection permits the Copy, Scaling and Watermark features to be locked and password protected.

Note
Record your password and keep it in a safe place for future reference. If you forget your password these settings can not be accessed.

Insert Command/File (For Windows® 98/98SE/Me Users Only)
(MFC-7225N and MFC-7820N only)
This option allows data to be inserted into a print job.
Using this function allows you to do the following.
• Insert a print file or tiff format file into a print job.
• Insert a text string into a print job.

Insert a macro, which is saved in printer memory, into a print job.

Page Protection
Page Protection refers to a setting that reserves additional memory for the creation of full page images.
Selections are AUTO, OFF and Printer Default.
The page protection feature allows the machine to create the full page image to be printed in memory before physically moving the paper through the machine. When the image is very complicated and the machine has to wait to process the image before printing, use this function.
Using the machine as a printer

Print Date & Time

When enabled the Print Date & Time feature, it will print the date and time on your document from your computer’s system clock.

Click the Setting button to change the Date, Time, Position and Font. To include a background with the Date and Time, select Opaque. When Opaque is selected, you can set the Darkness of the Date and Time background by changing the percentage.

Note

The Date and Time in the selection box shows the format that will be printed. The actual Date and Time printed on your document is automatically retrieved from the settings of your computer.

Density adjustment

Increase or decrease the print density.
Support tab

The Support Tab provides driver version and setting information. In addition there are links to the Brother Solutions Center and the Driver Update Web sites.

Click the Support tab to display the following screen:

Brother Solutions Center

The Brother Solutions Center is a Web site offering information about your Brother product including FAQs (Frequently Asked Questions), User's Guides, Driver Updates and Tips for using your machine.

Web Update

Web Update checks the Brother web site for updated drivers, and automatically downloads and updates the printer driver on your computer.

Print Settings

You can print a list of current printer settings.

Print Fonts (MFC-7225N and MFC-7820N only)

You can print the internal fonts list.

Check Setting

The Check Setting selection displays a list of your current driver settings.
Features in the PS (PostScript®) Brother printer driver (MFC-7225N and MFC-7820N only) (For Windows®)

The BR-Script 3 (PostScript® 3™ language emulation) driver supports Windows® 98/98SE/Me/2000 Professional/XP and Windows NT® 4.0.

To install the PS driver

If you have already installed the printer driver following the instruction in the Quick Setup Guide, insert the CD-ROM into the CD-ROM drive on your PC and click **Install MFL-Pro Suite** and follow the on-screen instructions. When the **Select Components** screen appears, check **PS Printer Driver**, and then continue following the on-screen instructions.

If you have not previously installed the driver and software, insert the CD-ROM into the CD-ROM drive on your PC and click **Install MFL-Pro Suite** and follow the on-screen instructions. When the **Setup Type** screen appears, select **Custom** and check the **PS Printer Driver**. Then continue following on-screen instructions.

**Note**

- The screens in this section are from Windows® XP. The screens on your PC will vary depending on your Operating System.
- You can download the latest driver by accessing the Brother Solutions Center at [http://solutions.brother.com](http://solutions.brother.com)

**Ports tab**

Select the port where your printer is connected or the path to the network printer you are using.
Using the machine as a printer

Layout tab

If you are using Windows NT® 4.0, Windows® 2000 or XP, you can access the Layout tab by clicking Printing Preferences... in the General tab of the Brother MFC-XXXX BR-Script3 Properties screen.

The Layout tab enables you to change various layout settings such as Orientation, Page Order and Page Per Sheet.

Paper / Quality tab

If you are using Windows NT® 4.0, Windows® 2000 or XP, you can access the Paper/Quality tab by clicking Printing Preferences... in the General tab of the Brother MFC-XXXX BR-Script3 Properties screen.

Select the Paper Source.

Advanced Options

If you are using Windows NT® 4.0, Windows® 2000 or XP, you can access the Brother MFC-XXXX BR-Script3 Advanced Options tab by clicking the Advanced... button in the Layout tab or the Paper/Quality tab.

Select the Paper Size and Copy Count.

Set the Print Quality, Scaling and TrueType Font setting.

You can change the following settings by selecting the setting in the Printer Features list:

- Media Type
- Toner Save
- BR-Script Level
Using the machine as a printer

Status Monitor (Windows® only)

The Status Monitor utility is a configurable software tool that allows you to monitor the status of one or more devices, allowing you to get immediate notification of errors such as paper empty or paper jam.

How to turn on the status monitor

1. Click Brother MFC-XXXX (USB) Printer or Brother DCP-XXXX (USB) Printer (Where XXXX is your model name and if you are connected by USB then USB will be in the printer driver name) located in the Start/All Programs/Brother/MFL-Pro Suite MFC-XXXX/Status Monitor on your computer. The Brother Status Monitor window will appear.

2. Right-click on the status monitor window and select Load Status Monitor on Startup in the menu.

3. Right-click on the status monitor window and select Location, and then select the way to display the status monitor on your computer—in the taskbar, in the tasktray, in the tasktray (on Error) or on the desktop.

Monitoring and viewing the machine’s status

The Status Monitor icon will change color depending on the machine’s status.

Green icon means a normal stand-by condition.

Yellow icon means a warning.

Red icon means a printing error has occurred.

Note

■ You can check the device status at anytime by double-clicking the icon in the tasktray or selecting the Status Monitor located in the Start/All Programs/Brother/MFL-Pro Suite MFC-XXXX on your computer.

■ For more information about using the Status Monitor software, right click the Status Monitor icon and choose Help.
Note
The scanning operations and drivers will be different depending on your operating system.

For Windows® XP
Two scanner drivers are installed. Windows Imaging Acquisition (WIA) driver (See Scanning a document using WIA driver (For Windows® XP only) on page 2-2.) and a TWAIN compliant scanner driver (See Scanning a document using the TWAIN driver on page 2-7.) If you are using Windows® XP you can select either driver when scanning documents.

For Windows® 98/98SE/Me/2000 Professional and Windows NT® 4.0
The machine uses a TWAIN compliant driver for scanning documents from your applications. (See Scanning a document using the TWAIN driver on page 2-7.)

For Macintosh®
The machine uses a TWAIN compliant driver when scanning documents for your applications.

Go to Scanning from a Macintosh® on page 7-13.

For ScanSoft®, PaperPort® 9.0SE and OmniPage® OCR (Windows® only)
Go to Using ScanSoft® PaperPort® 9.0SE and OmniPage® OCR on page 2-15.
Scanning a document using WIA driver
(For Windows® XP only)

WIA compliant

Windows® XP uses Windows® Image Acquisition (WIA) for scanning images from the machine. You can scan images directly into the PaperPort® 9.0SE viewer that Brother included with your machine or you can scan images directly into any other software application that supports WIA or TWAIN scanning.

How to access the scanner

1. Open your software application to scan the document.

   Note
   The instructions for scanning in this Guide are for when you use ScanSoft® PaperPort® 9.0SE. The steps for scanning from another application may vary.

2. Select Scan from the File drop-down menu or select the Scan button.

   The Scan panel appears on the left of the screen.

3. Select WIA-Brother MFC-XXXX or WIA-Brother DCP-XXXX from the Scanner drop-down list box.

   Note
   ■ If the machine is connected via:
     Parallel-use WIA-Brother MFC-XXXX or WIA-Brother DCP-XXXX
     USB-use WIA-Brother MFC-XXXX USB or WIA-Brother DCP-XXXX USB
     LAN-use WIA-Brother MFC-XXXX LAN or WIA-Brother DCP-XXXX LAN
     (Where XXXX is your model name.)
   ■ If you choose TW-Brother XXXXXXX, the TWAIN driver will run.

4. Click Scan.

   The Scan dialog box will appear:
Scanning a document into the PC (For MFC-7220 and MFC-7225N)

1. Load your document.
2. Select the picture type (B).
3. Select the Paper size from the drop-down list box (D).

4. If you require advanced settings, click Adjust the quality of the scanned picture (C). You can select Brightness, Contrast, Resolution and Picture Type from the Advanced Properties. Click the OK button after you choose your settings.

5. To start scanning your document, click the Scan button in the Scan dialog box.

Note
- You can select a resolution of up to 1200 dpi.
- For resolutions greater than 1200 dpi, use the Brother Scanner Utility. (See Brother Scanner Utility (not available for MFC-7220 and MFC-7225N) on page 2-6.)
- You can only select Document Feeder in the Paper source menu.
How to scan using Windows®

Scanning a document into the PC (DCP-7020, MFC-7420 and MFC-7820N Only)

There are two ways in which you can scan a whole page. You can either use the ADF (automatic document feeder) or the Flatbed scanner glass.

If you would like to scan and then crop a portion of the page after pre-scanning the document, you will need to use the scanner glass (Flatbed). (See Pre-Scanning to crop a portion you want to scan on page 2-9.)

Scanning a document using the ADF

1. Load your document.
2. Select the Document Feeder from the Paper source drop-down list box (A).
3. Select the picture type (B).
4. Select the Paper size from the drop-down list box (D).
5. If you require advanced settings, click on the tab Adjust the quality of the scanned picture (C). You can select Brightness, Contrast, Resolution and Picture Type from the Advanced Properties. Click the OK button after you choose your settings.

Note
- You can select a resolution of up to 1200 dpi.
- For resolutions greater than 1200 dpi, use the Brother Scanner Utility. (See Brother Scanner Utility (not available for MFC-7220 and MFC-7225N) on page 2-6.)

6. To start scanning your document, click the Scan button in the Scan dialog box.
How to scan using Windows®

Pre-Scanning to crop a portion you want to scan using the scanner glass (DCP-7020, MFC-7420 and MFC-7820N Only)

The Preview button is used to preview an image for cropping any unwanted portions from the image. When you are satisfied with the preview, click the Scan button from the scanner window to scan the image.

1. Place the document face down on the scanner glass.

Note
If your machine has no ADF, you can skip step 2.

3. Select the picture type (B).
4. In the Scan dialog box, click the Preview button. The entire document will be scanned into the PC and will appear in the scanning area.

5. To select the portion you want to scan, click and hold the left mouse button, then drag the mouse pointer over the area.

6. If you require advanced settings, click on the tab Adjust the quality of the scanned picture (C). You can select Brightness, Contrast, Resolution and Picture Type from the Advanced Properties. Click the OK button after you choose your settings.

7. To start scanning your document, click the Scan button in the Scan dialog box. This time only the selected area of the document will appear in the PaperPort® 9.0SE window (or your software application window).
Brother Scanner Utility (not available for MFC-7220 and MFC-7225N)

The Scanner Utility is used for configuring the scanner driver for resolutions greater than 1200 dpi and for changing the maximum scanning size. If you want to set Legal size as the default size, change the setting using this utility. You must restart your PC for the new settings to take effect.

To run the utility:

You can run the utility by selecting the Scanner Utility located in the Start/All Programs/Brother/MFL-Pro Suite MFC-XXXXX menu. (Where XXXX is your model name.)

Note

If you scan the document at a resolution of greater than 1200 dpi, the file size may be very large. Please make sure that you have sufficient memory and hard disk space for the size of the file you are trying to scan. If the memory and hard disk is not sufficient then your computer may freeze and you could lose your file.
How to scan using Windows®

Scanning a document using the TWAIN driver

TWAIN compliant

The Brother MFL-Pro Suite software includes a TWAIN compliant scanner driver. TWAIN drivers meet the standard universal protocol for communicating between scanners and software applications. This means that not only can you scan images directly into the PaperPort® 9.0SE viewer that Brother included with your machine, but you can also scan images directly into hundreds of other software applications that support TWAIN scanning. These applications include popular programs like Adobe® PhotoShop®, Adobe® PageMaker®, CorelDraw® and many more.

How to access the Scanner

1. Open the software application (ScanSoft® PaperPort® 9.0SE) to scan a document.

   Note
   The instructions for scanning in this Guide are for when you use ScanSoft® PaperPort® 9.0SE.

2. Select Scan from the File drop-down menu or select the Scan button. The Scan panel appears in the left panel.

3. Select the scanner you are using from the Scanner drop-down list box.

   Note
   If the machine is connected via:
   Parallel-use Brother MFC-XXXX or Brother DCP-XXXX
   USB-use Brother MFC-XXXX USB or Brother DCP-XXXX USB
   LAN-use Brother MFC-XXXX LAN or Brother DCP-XXXX LAN
   (Where XXXX is your model name.)

   If you are using Windows® XP, select TW-Brother MFC-XXXX, not WIA-Brother MFC-XXXX.

4. Click Scan.

   The Scanner Setup dialog box will appear:
Scanning a document into the PC

You can scan a whole page
—OR—
Scan a portion of the page after pre-scanning the document.

Scanning a whole page

1. Load your document.

2. Adjust the following settings, if required, in the Scanner window:
   - Image Type (A)
   - Resolution (B)
   - Scan Type (C)
   - Brightness (D)
   - Contrast (E)
   - Document Size (F)

   **Note**
   After you select a document size, you can adjust the scanning area further by clicking the left mouse button and dragging it. This is required when you want to crop an image when scanning. (See Settings in the Scanner window on page 2-10.)

3. Click the Start button in the scanner window.
   When scanning is completed, click Cancel to return to the PaperPort® 9.0SE window.
Pre-Scanning to crop a portion you want to scan

The PreScan button is used to preview an image for cropping any unwanted areas from the image. When you are satisfied with the preview, click the Start button in the scanner window to scan the image.

1. Load your document.

2. Select the settings for Image Type, Resolution, Scan Type, Brightness, Contrast and Document Size, as needed.

3. In the Scanner Setup dialog box, click the PreScan button. The entire document will be scanned into the PC and will appear in the Scanning Area.

4. To select the portion you want to scan, click and hold the left mouse button, then drag the mouse pointer over the area.

   ! Note
   If you enlarge the image using the button, you can then use the button to restore the image to its former size.

5. Load your document again.

   ! Note
   If you have a flatbed type model, and you loaded your document onto the scanner glass in step 1, please skip this step.

6. Click Start.

   This time only the selected area of the document will appear in the PaperPort® 9.0SE window (or your software application window).

7. In the PaperPort® 9.0SE window, use the options available to refine the image.
How to scan using Windows®

Settings in the Scanner window

Image Type
Select the image type of output from Photo, Web or Text. Resolution and Scan Type will be altered for each default setting.

The default settings are:
(For DCP-7020, MFC-7420 and MFC-7820N)

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Resolution</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td>300 x 300 dpi</td>
<td>24-bit color</td>
</tr>
<tr>
<td>Web</td>
<td>100 x 100 dpi</td>
<td>24-bit color</td>
</tr>
<tr>
<td>Text</td>
<td>200 x 200 dpi</td>
<td>Black &amp; White</td>
</tr>
</tbody>
</table>

(For MFC-7220 and MFC-7225N)

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Resolution</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td>300 x 300 dpi</td>
<td>True Gray</td>
</tr>
<tr>
<td>Web</td>
<td>100 x 100 dpi</td>
<td>True Gray</td>
</tr>
<tr>
<td>Text</td>
<td>200 x 200 dpi</td>
<td>Black &amp; White</td>
</tr>
</tbody>
</table>

Resolution
You can change the scanning resolution from the Resolution drop down list. Higher resolutions take more memory and transfer time, but can achieve a finer scanned image. The following list shows the resolution you can choose.

- 100 x 100 dpi
- 150 x 150 dpi
- 200 x 200 dpi
- 300 x 300 dpi
- 400 x 400 dpi
- 600 x 600 dpi
- 1200 x 1200 dpi
- 2400 x 2400 dpi (not available for MFC-7220 and MFC-7225N)
- 4800 x 4800 dpi (not available for MFC-7220 and MFC-7225N)
- 9600 x 9600 dpi (not available for MFC-7220 and MFC-7225N)
How to scan using Windows®

Scan Type

<table>
<thead>
<tr>
<th>Black &amp; White:</th>
<th>Set the Scan Type to Black &amp; White for text or line art.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray Scale:</td>
<td>Set the Scan Type to Gray (Error Diffusion) or True Gray for photographic images.</td>
</tr>
<tr>
<td>Colors:</td>
<td>Set the Scan Type to Gray (Error Diffusion) or True Gray for photographic images.</td>
</tr>
<tr>
<td></td>
<td>Note: The Brightness setting is only available when Black &amp; White or Gray (Error Diffusion) or True Gray is selected.</td>
</tr>
</tbody>
</table>

Brightness

Adjust the setting (-50 to 50) to obtain the best image. The default value is 0, representing an ‘average’. You can set the level by dragging the slide bar to the right or left to lighten or darken the image. You can also type a value in the box for the setting.

If the scanned image is too light, set a lower brightness value and scan the document again. If the image is too dark, set a higher brightness value and scan the document again.

Note: The Brightness setting is only available when Black & White or Gray (Error Diffusion) or True Gray is selected.

Contrast

You can increase or decrease the contrast level by moving the slide bar to the left or right. An increase emphasizes dark and light areas of the image, while a decrease reveals more detail in gray areas. You can also type a value in the box for the setting.

Note: The Contrast setting is only adjustable when you have selected one of the gray scale settings. It is not available when Black & White and Color settings are selected as the Scan Type.
Document Size

Set the size to one of the following:

- A4 210 x 297 mm
- JIS B5 182 x 257 mm
- Letter 8 1/2 x 11 in
- Legal 8 1/2 x 14 in
- A5 148 x 210 mm
- Executive 7 1/4 x 10 1/2 in
- Business Card
- Photo 4 x 6 in
- Index Card 5 x 8 in
- Photo L 89 x 127 mm
- Photo 2L 127 x 178 mm
- Postcard 1 100 x 148 mm
- Postcard 2 148 x 200 mm
- Custom (User adjustable from 0.35 x 0.35 in. to 8.5 x 14 in or 8.9 x 8.9 mm to 215.9 x 355.6 mm.)

If your machine is a flatbed type (except MFC-7220 and MFC-7225N), you can scan business cards. To scan business cards, select the business card size, and then place the business card face down at the center of the scanner glass.

When scanning photographs or other images for use in a word processor or other graphics application, you should try different settings for the contrast and resolution modes to see which best suits your needs.

If you selected Custom as the size, the Custom Document Size dialog box will appear.

Type the Name, Width and Height for the document.

You can choose “mm” or “inch” as the unit for Width and Height.

Note

You can see the actual paper size you selected on the screen.

- **Width**: shows the width of scanning area
- **Height**: shows the height of scanning area
- **Data Size**: shows the approximate data size calculated in a Bitmap format. The size will be different for other file formats such as JPEG.
Using the Scan key (For USB or Parallel cable users)

Note
If you use the Scan key on a network, please refer to Using the Scan key on page 6-3.

You can use the Scan key on the control panel to scan documents into your word processing, graphics or E-mail applications or your computer folder. The advantage of using Scan is that you avoid the mouse clicks required to scan from your computer.

Note
■ Before you can use the Scan key on the control panel, you must have connected the machine to your Windows® based computer and loaded the appropriate Brother Drivers for your version of Windows®. For details about how to configure the ControlCenter2.0 buttons to launch the application of your choice using the Scan key, go to the appropriate chapter:
  • For Windows®, see Using ControlCenter2.0 (For Windows®) on page 3-1.
  • For Macintosh®, see Using ControlCenter2.0 (For Mac OS® X 10.2.4 or greater) on page 7-24.

Scan to E-mail

You can either scan a black and white document (or color document for the DCP-7020, MFC-7420 and MFC-7820N) into your E-mail application as a file attachment. You can change the Scan configuration. (See E-mail on page 3-5.)

1 Load your document.
2 Press Scan.
3 Press ▲ or ▼ to select Scan to E-mail.
   Press Menu/Set or Set.
   The machine will scan the document, create a file attachment, and launch your E-mail application, displaying the new message waiting to be addressed.
How to scan using Windows®

**Scan to Image**

You can scan a picture into your graphics application for viewing and editing. You can change the scan configuration. (See *Image (example: Microsoft Paint)* on page 3-4.)

1. Load your document.
2. Press Scan.
3. Press ▲ or ▼ to select Scan to Image.
   - Press Menu/Set or Set.
   - The machine will start the scanning process.

**Scan to OCR**

If your document is text, you can have it converted by ScanSoft® OmniPage® OCR to an editable text file and then have the result displayed in your word processing application for viewing and editing. You can change the scan configuration. (See *OCR (Word Processing program)* on page 3-5.)

1. Load your document.
2. Press Scan.
3. Press ▲ or ▼ to select Scan to OCR.
   - Press Menu/Set or Set.
   - The machine will start the scanning process.

**Scan to File**

You can scan a black and white or a color document into your computer and save it as a file in the folder you choose. The file type and specific folder are based on the settings you have chosen in the Scan to File screen of ControlCenter2.0. (See *File* on page 3-6.)

1. Load your document.
2. Press Scan.
3. Press ▲ or ▼ to select Scan to File.
   - Press Menu/Set or Set.
   - The machine will start the scanning process.
Using ScanSoft® PaperPort® 9.0SE and OmniPage® OCR

ScanSoft® PaperPort® 9.0SE for Brother is a document management application. You can use PaperPort® 9.0SE to view scanned documents.

PaperPort® 9.0SE has a sophisticated, yet easy-to-use, filing system that will help you organize your graphics and text documents. It allows you to combine or “stack” documents of different formats for printing, faxing or filing.

ScanSoft® PaperPort® 9.0SE can be accessed through the ScanSoft® PaperPort® 9.0SE program group.

This chapter is only an introduction to the basic operations of ScanSoft® PaperPort® 9.0SE.

The complete ScanSoft® PaperPort® 9.0SE User’s Guide, including ScanSoft® OmniPage® OCR, is in the Documentation located on the CD-ROM.

When you install MFL-Pro Suite, ScanSoft® PaperPort® 9.0SE for Brother and ScanSoft® OmniPage® OCR are installed automatically.

Note

If you are using Windows® XP or Windows® 2000 Professional, you must be logged on with administrator rights.
Viewing items

ScanSoft® PaperPort® 9.0SE provides several ways to view items:

**Desktop View** displays a thumbnail (a small graphic that represents each item in a Desktop or folder).

Items in the selected folder appear on the PaperPort® 9.0SE Desktop. You can see PaperPort® 9.0SE items (MAX files) and non-PaperPort® 9.0SE items (files created using other applications).

Non-PaperPort® 9.0SE items include an icon that indicates the application that was used to create the item; a non-PaperPort® 9.0SE item is represented by a small rectangular thumbnail and not an actual image.

**Page View** displays a close-up of a single page and you can open a PaperPort® 9.0SE item by double-clicking on it.

As long as you have the appropriate application on your computer to display it, you can also double-click a non-PaperPort® 9.0SE item to open it.

Organizing your items in folders

PaperPort® 9.0SE has an easy-to-use filing system for organizing your items. The filing system consists of folders and items that you select to view in Desktop View. An item can be a PaperPort® 9.0SE item or a non-PaperPort® 9.0SE item:

- Folders are arranged in a “tree” structure in the Folder View.
  You use this section to select folders and view their items in Desktop View.
- You can simply drag and drop an item onto a folder.
  When the folder is highlighted, release the mouse button and the item is stored in that folder.
- Folders can be “nested”—that is, stored in other folders.
- When you double-click a folder, its items (both PaperPort® 9.0SE MAX files and non PaperPort® 9.0SE files) appear on the Desktop.
- You can also use Windows® Explorer to manage the folders and items shown in Desktop View.
Quick links to other applications

ScanSoft® PaperPort® 9.0SE automatically recognizes many other applications on your computer and creates a “working link” to them.

The Send To Bar at the bottom of the Desktop view shows icons of those linked applications.

To use a link, drag an item onto one of the icons to start the application represented by the icon. A typical use of the Send To Bar is to select an item and then fax it.

This sample Send To Bar shows several applications with links to PaperPort® 9.0SE.

If PaperPort® 9.0SE does not automatically recognize one of the applications on your computer, you can manually create a link using the New Program Link... command.
(See PaperPort® 9.0SE in the Documentation section on the CD-ROM for more information about creating new links.)

ScanSoft® OmniPage® OCR lets you convert image text into text you can edit

ScanSoft® PaperPort® 9.0SE can quickly convert the text on a ScanSoft® PaperPort® 9.0SE item (which is really just a picture of the text) into text that you can edit with a word processing application.

PaperPort® 9.0SE uses the optical character recognition application ScanSoft® OmniPage® OCR, which comes with PaperPort® 9.0SE.

— OR —

PaperPort® 9.0SE can use your preferred OCR application if it is already on your computer. You can convert the entire item, or by using the Copy Text command, you can select only a portion of the text to convert.

Dragging an item onto a word-processing link icon starts PaperPort® 9.0SE’s built-in OCR application, or you can use your own OCR application.

Importing items from other applications

In addition to scanning items, you can bring items into PaperPort® 9.0SE in a variety of ways and convert them to PaperPort® 9.0SE (MAX) files in several different ways:

- Print to the Desktop View from another application, such as Microsoft® Excel.
- Import files saved in other file formats, such as Windows® Bitmap (BMP) or Tagged Image File Format (TIFF).
Exporting items in other formats

You can export or save PaperPort® 9.0SE items in several popular file formats, such as BMP, JPEG, TIFF, PDF or self-viewing.

For example, to create a file for an Internet Web site, export it as a JPEG file. Web pages often use JPEG files for displaying images.

Exporting an image file

1. Select the **Save As** command from the File pull-down menu in the PaperPort® 9.0SE window. The Save ‘XXXXX’ as dialog box will be displayed.

2. Select the drive and directory where you want to store the file.

3. Enter the new file name and choose the file type or select a name from the File Name text box. (You can scroll through the Directories and File Name listing for prompting.)

4. Select the **Save** button to save your file, or **Cancel** to return to the PaperPort® 9.0SE without saving it.

How to Uninstall PaperPort® 9.0SE and ScanSoft® OmniPage® OCR

*For Windows® 98/98SE/Me and Windows NT® 4.0:*
Select **Start**, **Settings**, **Control Panel**, **Add/Remove Programs** and the **Install/Uninstall** tab.
Select **PaperPort** from the list and click the **Add/Remove** button.

*For Windows® 2000 Professional:*
Select **Start**, **Settings**, **Control Panel** and **Add/Remove Programs**.
Select **PaperPort** from the list and click the **Change/Remove** button.

*For Windows® XP:*
Select **Start**, **Control Panel**, **Add or Remove Programs**.
Select **PaperPort** from the list and click the **Change** or **Remove** button.
ControlCenter2.0 is a software utility that allows you to quickly and easily access your frequently used applications. Using ControlCenter2.0 eliminates the need to manually launch the specific applications. ControlCenter2.0 provides the following six categories of operations:

1. Scan directly to a file, E-mail, word processor or graphics application of your choice.
2. Custom Scan buttons allow you to configure a button to meet your own application requirements.
3. Access the Copy features available via your computer.
4. Access the “PC-FAX” applications available for your device. (not available for DCP-7020)
5. Access the settings available to configure your device. (not available for DCP-7020)

You can select which machine ControlCenter2.0 will connect with from the Model pull-down list. Also you can open the configuration window for each function by clicking the Configuration button.

**Note**

The functions that can be used in ControlCenter2.0 may vary depending upon the model.

To be able to choose another connected model from the model pull-down list, you must have the MFL-Pro Software installed on your PC for that model.
How to turn off the AutoLoad feature in ControlCenter2.0

Once you start ControlCenter2.0 from the Start menu, the icon will appear on the task bar. You can open the ControlCenter2.0 window by double-clicking on the icon.

If you do not want ControlCenter2.0 to run automatically each time the computer is started;

1. Right-click on the ControlCenter2.0 icon in the Task Tray, and select **Preference**.

2. The ControlCenter2.0 preference window appears, then uncheck the **Start ControlCenter on computer startup** check box.

3. Click **OK** to close the window.

SCAN

This section contains four buttons for **Scan to Image**, **Scan to OCR**, **Scan to E-mail** and **Scan to File** applications.

- **Image** *(Default: Microsoft Paint)* — enables you to scan a page directly into any graphic viewer/editor application. You can select the destination application, such as MS Paint, Corel PhotoPaint, Adobe Photoshop, or any kind of image editing application you have installed on your computer.

- **OCR** *(Default: MS WordPad)* — enables you to scan a page or document, automatically run the OCR application and insert the text and any graphic images into a word processing application. You have the option of selecting the target word processing application, such as WordPad, MS Word, Word Perfect or whichever word processing application is installed on your computer.

- **E-mail** *(Default: your default E-mail software)* — enables you to scan a page or document directly into an E-mail application as a standard attachment. You have the option of selecting the file type and resolution for the attachment.

- **File** — enables you to scan directly to a file and save it to disk. You can change the file type and destination folder, as needed.

ControlCenter2.0 gives you the ability to configure the hardware **Scan** key on your machine for each scan feature. Select the **Device Button** in the configuration menu for each of the **SCAN** buttons.

CUSTOM SCAN

You can configure the button name and settings for each of these buttons to meet your specific requirements by right-clicking on a button and following the configuration menus.
COPY

Copy — allows you to use the PC and any printer driver for enhanced copy operations. You can scan the page on the machine and print the copies using any of the features of the machine printer driver—OR—you can direct the copy output to any standard printer driver installed on the PC including network printers.

You can configure your preferred settings on up to four buttons.

PC-FAX (not available for DCP-7020)

These buttons are for sending or receiving faxes using the Brother PC-FAX application.

- **Send** — enables you to scan a page or document and automatically send the image as a fax from the PC using the Brother PC-FAX software. (See **PC-FAX sending** on page 5-1.)
- **Receive** — enables you to receive a PC-FAX by clicking this button. After running the PC-FAX receive software, this button changes to View Received to open the application and see the received fax. (See **Setting up PC-FAX receiving** on page 5-12.) Before you use the PC-FAX Receive function, you must select the option of PC-FAX Receive from the Control Panel menu on the machine. (See **Setting PC Fax Rx** in the User's Guide.)

**Note**

When the machine is connected to a network, you cannot use the **Receive** function.

- **Address Book** — enables you to open Brother PC-FAX address book. (See **Brother Address Book** on page 5-6.)
- **Setup** — enables you to configure the PC-FAX sending settings. (See **Sending setup** on page 5-2.)

DEVICE SETTING (not available for DCP-7020)

You can configure the machine settings.

- **Remote Setup** — enables you to open the Remote Setup Program. (See **MFC Remote Setup** on page 4-1.)
- **Quick-Dial** — enables you to open the Set Quick-Dial window of the Remote Setup. (See **MFC Remote Setup** on page 4-1.)

**Note**

When the machine is connected to a network, you cannot use the **Remote Setup** and **Quick-Dial** function.
SCAN

This section contains four buttons for Scan to Image, Scan to OCR, Scan to E-mail and Scan to File applications. These four selections can be accessed from ControlCenter2.0 or from the Scan key on the control panel of the machine. The target application, file type and scan settings are configured independently by choosing the Software Button or the Device Button tabs of ControlCenter2.0 configuration window.

Image (example: Microsoft Paint)

Scan to Image feature allows you to scan an image directly into your graphics application for image editing. To change the default settings, right-click on the button and select Software Button or Device Button.

To change the destination application, select the appropriate application from the Target Application pull down list. You can add an application to the list by clicking the Add button. Enter the Application Name (up to 30 characters) and the Application Location. You can also find the application location by clicking the button. Choose the File Type from the pull-down list.

You can delete applications that you have added by selecting the Application Name and click the Delete button.

To change the file type or Scan settings make your selections from the appropriate pull down list.

Note

This function is also available for Scan to E-mail and Scan to OCR. The window may vary depending upon the function.
OCR (Word Processing program)

Scan to OCR converts the graphic page image data into text which can be edited by any word processor program. You can change the default word processor program.

To configure Scan to OCR, right-click on the button and select Software Button or Device Button.

To change the word processing application, select the destination word processing application from the Target Application pull down list. You can add an application to the list by clicking the Add button. An application can be deleted by clicking on the Delete button.

You can also configure the other settings for this selection.

E-mail

Scan to E-mail feature allows you to scan a document to your default E-mail application, so you can send the scanned job as an attachment. To change the default E-mail application or attachment file type, right-click on the button and select Software Button or Device Button.

To change the E-mail application, select your preferred E-mail application from the E-mail Application pull down list. You can add an application to the list by clicking the Add button. An application can be deleted by clicking on the Delete button.

You can also change the other settings used to create the file attachments.
File attachments

You can choose from the following list of file types for attachment to your E-mail or for saving to a folder.

File Type — Select from the pull-down list the type of file you want the scanned images to be saved in.

- Windows Bitmap (*.bmp)
- JPEG (*.jpg)
- TIFF - Uncompressed (*.tif)
- TIFF - Compressed (*.tif)
- TIFF Multi-Page - Uncompressed (*.tif)
- TIFF Multi-Page - Compressed (*.tif)
- Portable Network Graphics (*.png)
- PDF (*.pdf)

Note
Additional file format support is available by scanning to PaperPort® 9.0SE and then use the save as function and choose the file format. (See Using ScanSoft® PaperPort® 9.0SE and OmniPage® OCR on page 2-15.)

The additional file types supported are:
- TIFF - Group 4 (*.tif)
- TIFF - Class F (*.tif)
- TIFF Multi Page - Group 4 (*.tif)
- TIFF Multi Page - Class F (*.tif)

File

Scan to File button allows you to scan an image and save it in a specific file type to any directory on your PC. This allows you to easily archive your paper documents. To configure the file type and save to directory, right-click on the button and select Software Button or Device Button.

Select the file type for the saved image by selecting from the File Type pull-down list. You can save the file to the default folder which is shown currently in the Destination Folder box, or you can select another folder/directory by clicking button.

Note
For the supported file types, please refer to the File attachments on page 3-6.
CUSTOM SCAN

There are four buttons from which you can set your own preferences and configuration to fit your required usage for scanning.

To configure a button, right-click on the button, and the configuration window will appear. You have four function choices of scan action, **Scan to Image**, **Scan to OCR**, **Scan to E-mail**, and **Scan to File**.

- **Scan to Image**: This setting allows you to scan a page directly into any graphic viewer/editor software. You can select any kind of image editor application you have installed on your computer as a destination application.

- **Scan to OCR**: Scanned documents will be converted to editable text files. If you have a third party OCR software package installed on your PC you can select it. You can also select the destination application for the editable text.

- **Scan to E-mail**: Scanned images will be attached to an E-mail message. You can choose which E-mail application to use if you have more than one installed on your system. You can also select the file type for the attachment and create a quick send list of E-mail addresses chosen from your default E-mail address book.

- **Scan to File**: This setting allows you to save a scanned image to any directory on a local or network hard disk. You can also select the file type to be used.
Customizing a user-defined button

To configure a button, right-click on the button, and the configuration window will appear. Please read the following guidelines to configure the button.

Scan to Image:

In the General tab
You can enter up to a 30 character name in the Name for Custom field. This name will appear as the button name.
Select the type of scan from the Scan Action field.

In the Settings tab
You can select Target Application, File Type, Resolution, Scan Type, Document Size, Brightness and Contrast settings.

Scan to OCR:

In the General tab
You can enter up to a 30 character name in the Name for Custom field. This name will appear as the button name.
Select the type of scan from the Scan Action field.
Using ControlCenter2.0 (For Windows®)

In the **Settings** tab
You can select **Target Application**, **File Type**, **OCR Software**, **Resolution**, **Scan Type**, **Document Size**, **Brightness** and **Contrast** settings.

**Scan to E-mail:**
In the **General** tab
You can enter up to a 30 character name in the **Name for Custom** field. This name will appear as the button name.
Select the type of scan from the **Scan Action** field.

In the **Settings** tab
You can select **E-mail Application**, **File Type**, **Resolution**, **Scan Type**, **Document Size**, **Brightness** and **Contrast** settings.
Scan to File:

In the General tab
You can enter up to a 30 character name in the Name for Custom field. This name will appear as the button name.
Select the type of scan from the Scan Action field.

In the Settings tab
Select the file format from the File Type pull down list. You can either send the file to the default folder which is shown currently in the Destination Folder box or select your preferred folder by using button.
You can also select Resolution, Scan Type, Document Size, Brightness and Contrast settings.
COPY

The Copy buttons (1-4) can be customized to allow you to take advantage of the features built into the Brother printer drivers to do advanced copy functions such as N-in-1 printing.

Before you can use the Copy buttons you must first configure the printer driver by right-clicking on the button.

You can enter up to a 30 character name in the Name for Copy field and select the Copy Ratio.

In the Scan setting field you can select the Resolution, Scan Type, Document Size, Brightness and Contrast settings to be used.

Before finishing the Copy button configuration, you must set the Printer Name. Then click the Print options button to display the printer driver settings.

Note

The Print options screen will vary depending upon which model printer you have selected.

In the printer driver settings window you can choose advanced settings for printing.

Note

You must configure each of the copy buttons before they can be used.
PC-FAX (not available for DCP-7020)

This section allows you to easily open the software for sending or receiving a PC-FAX or edit the address book by clicking the appropriate button.

Send

The Send button allows you to scan a document and automatically send the image as a fax from the PC using the Brother PC-FAX software. (See PC-FAX sending on page 5-1.)

To change the Send settings, right-click on the button to open the configuration window. You can change Resolution, Scan Type, Document Size, Brightness and Contrast settings.

Receive / View Received

The Receive button allows you to start receiving PC-FAXes to your computer. By clicking this button, the PC-FAX receiving software is activated and starts receiving fax data. (See Running PC-FAX Receiving on page 5-12.)

Note

When the machine is connected to the network, you cannot use this function.

When the PC-FAX receiving software is running, the View Received button will appear to open the viewer application. (PaperPort® 9.0SE)
Address Book

The **Address Book** button allows you to configure add/amend or delete contacts from your address book. By clicking the button, the address book window will open for your editing. (See *Brother Address Book* on page 5-6.)

Setup

By clicking the **Setup** button, you can configure the user settings used by the PC-FAX application. (See *Setting up user information* on page 5-1.)
DEVICE SETTING (not available for DCP-7020)

In this section you can configure the machine settings by clicking the button.

Note

When the machine is connected to a network, you cannot use this function.

Remote Setup

The Remote Setup button allows you to open the Remote Setup Program window with which you can configure the machine setting menus.

Quick-Dial

The Quick-Dial button allows you to open the Set Quick-Dial window of the Remote Setup Program, so you can easily register or change the dial numbers from your PC to the machine.
MFC Remote Setup

The MFC Remote Setup application enables you to configure many MFC settings from a Windows® application. When you access this application, the settings on your machine will be downloaded to your PC and displayed on your computer screen. If you change the settings, you can upload them directly to the machine.

Note
You cannot use the MFC Remote Setup application if your machine is connected via a Network. (See Network User’s Guide.)

From the Start menu, select Programs, Brother, MFL-Pro Suite MFC-XXXX (Where XXXX is your model name), and then select MFC Remote Setup.

OK button
When you click OK, the process of uploading the data to the machine begins. The MFC Remote Setup program is closed if an error message is displayed, enter the correct data again and then click OK.

Cancel button
The Cancel button clears your changes and exits the MFC Remote Setup application without uploading any data to the machine.

Apply button
The Apply button uploads the data to the machine, but stays in the Remote Setup application so you can make more changes.

Print button
The Print button prints the selected items on the machine. You cannot print the MFC Remote Setup changes until you click the Apply button to upload the new data to the machine. Then you can click the Print button to get an up-to-date printout.

Export button
Click the Export button to save your current settings to a file.

Import button
Click the Import button to read the settings from your saved file into the MFC Remote Setup screen.

Note
You can use the Export and Import buttons to save and use several sets of settings for your machine.
Using Brother PC-FAX software
(For Windows®)
(not available for DCP-7020)

PC-FAX sending

The Brother PC-FAX feature allows you to use your PC to send any application or document file as a standard fax. You can create a file in any application on your PC, and then send it as a PC-FAX. You can even attach a cover page note. All you have to do is set up the receiving parties as Members or Groups in your PC-FAX Address Book or simply enter the destination address or fax number into the User interface. You can use the Address Book Search feature to quickly find members to send your fax to.

Note
- The maximum amount of faxes that can be sent as “broadcast” using PC-FAX is 50 fax numbers.
- If you are using Windows® XP or Windows® 2000 Professional, you need to log on with administrator rights.
- Please check Brother Solutions Center for the latest updates available for Brother PC-FAX. Visit http://solutions.brother.com/

Setting up user information

1. From the Start menu, select Programs, Brother, MFL-Pro Suite MFC-XXXX (Where XXXX is your model name), and then select PC-FAX Setup.
   
   The Brother PC-FAX Setup dialog box will appear:

2. You must enter this information to create the Fax Header and Cover Page.

3. Click OK to save the User Information.

Note
You can access the User Information from the FAX Sending dialog box by clicking .
(See Sending a file as a PC-FAX using the Facsimile style user interface on page 5-10.)
Sending setup

From the Brother PC-FAX Setup dialog box, click the Sending tab.

The user has the choice of two user interfaces: Simple style or Facsimile style. To change the user interface select the interface setting you want: Simple style or Facsimile style. (See User interface on page 5-3.)

Outside line access

If you need to enter a number to access an outside line, enter it here. This is sometimes required by a local PBX telephone system (for example, if you must dial 9, to get an outside line in your office).

Include header

To add header information to the top of the fax pages you send, check the Include header box.
User interface

In the Sending tab, select the user interface you wish to use. You can choose the Simple Style or the Facsimile Style.

Simple style

Facsimile style
Address Book

If Outlook® Express is installed on your PC, you can select which address book to use for PC-FAX sending, Brother Address Book or Outlook® Express from the Address Book tab.

For the Address book file, you must enter the path and file name of the database file which contains the address book information.

—OR—

Use the Browse button to find the database to select.

If you select Outlook® Express, you can use the Outlook® Express Address book when clicking the Address Book button on the sending window.
Setting up a Cover Page

From the PC-FAX dialog box, click to access the PC-Fax Cover page setup screen.

The Brother PC-FAX Cover Page Setup dialog box will appear:

![Brother PC-FAX Cover Page Setup dialog box](image)

Entering Cover Page Information

**To**

Type the comment you want to add to the cover page.

**From**

Select the cover page format you want to use.

**Comment**

You can insert a bitmap file, such as your company logo, in the cover page. Use the browse button to select the BMP file, and then select the alignment style.

**Count cover page**

When the Count Cover Page box is checked, the Cover Page will be included in the page numbering. When this box is not checked, the Cover Page will not be included.

Note

If you are sending a fax to more than one recipient, the recipient information will not be printed on the Cover Page.
Using Brother PC-FAX software (For Windows®)

Speed-Dial setup

From the Brother PC-FAX Setup dialog box, click the Speed-Dial tab. (To use this feature, you must select the Facsimile Style user interface.)

You can register a Member or Group on each of the ten Speed-Dial buttons.

To register an address in a Speed-Dial button:

1. Click the Speed-Dial button you want to program.
2. Click the Member or Group you want to store on the Speed-Dial button.
3. Click Add >> to save it.

To clear a Speed-Dial button:

1. Click the Speed-Dial button you want to clear.
2. Click Clear to erase it.

Brother Address Book

From the Start menu, select Programs, Brother, MFL-Pro Suite MFC-XXXX (Where XXXX is your model name), and then click PC-FAX Address Book.

The Brother Address Book dialog box will appear:
Setting up a Member in the Address Book

In the Brother Address Book dialog box you can add, edit and delete stored information of Members and Groups.

1. In the Address Book dialog box, click the icon to add a Member.
   The Brother Address Book Member Setup dialog box will appear:

2. In the Member Setup dialog box, type the Member’s information. **Name** is a required field. Click **OK** to save the information.

Setting up a Group for Broadcasting

If you often send the same PC-FAX to several recipients, you can combine them into a Group.

1. In the Brother Address Book dialog box, click the icon to create a Group.
   The Brother Address Book Group Setup dialog box appears:

2. Type the name of the new Group in the **Group Name** field.

3. In the **Available Names** box, select each Member to be included in the Group, and then click **Add >>**.
   Members you add to the Group will be added to the **Group Members** box.

4. After all the members you want have been added, click **OK**.

Editing Member information

1. Select the Member or Group you want to edit.

2. Click the edit icon.

3. Change the Member or Group information.

4. Click **OK** to save your changes.
Deleting a Member or Group

1. Select the Member or Group you want to delete.
2. Click the delete icon.
3. When the Confirm Item Delete dialog box appears, click OK.

Exporting the Address Book

You can export the whole Address Book to an ASCII text file (*.csv). Or if you wish, you can select and create a Vcard that will be attached to that Member’s outgoing E-mail. (A Vcard is an electronic business card that contains the sender’s contact information.)

To export the whole current Address book:

Note
If you are creating a Vcard, you must first select the member.
If you select Vcard in Step 1, Save as type: will be Vcard (*.vcf).

1. From the Address Book select File, point to Export, and then click Text.
   —OR—
   Click Vcard and go to Step 5.
2. From the Available Items column, select the data fields you wish to Export and then click Add >>.
   
   Note
   Select the items in the order you want them listed.

3. If you are exporting to an ASCII file, select the Divide Character - Tab or Comma. This selects between a Tab or Comma to separate the data fields.
4. Select OK to save the data.
5. Type the name of the file, and then select Save.
Importing to the Address Book

You can import ASCII text files (*.csv) or Vcards (electronic business cards) into your Address Book.

To import an ASCII text file:

1. From the Address Book select File, point to Import, and then click Text.
   —OR—
   Click Vcard and go to Step 5.

2. From the Available Items column select the data fields you want to import, and click Add >.

   Note
   From the Available Items list select the fields in the same order they are listed in the Import text file.

3. Select the Divide Character - Tab or Comma based on the file format you are importing.

4. To import the data, click OK.

5. Type the name of the file, and then select Open.

   Note
   If you selected a text file in Step 1, the Files of type: will be Text file (*.csv).
Sending a file as a PC-FAX using the Facsimile style user interface

1. Create a file in Word, Excel, Paint, Draw or any other application on your PC.

2. From the File menu, select Print.
   - The Print dialog box will appear:

3. Select Brother PC-FAX as your printer, and then click Print.
   - The Facsimile style user interface will appear, if it does not check the user interface selection setting as detailed on page 5-2.

4. Enter the fax number using any of the following methods:
   - Using the dial pad enter the number.
   - Click any of the 10 Speed-Dial buttons.
   - Click the Address Book button, and then select a Member or Group from the Address Book.

   **Note**
   If you make a mistake, click Clear to delete all the entries.

5. To include a Cover Page, click Cover Page On, and then click the Cover Page icon to enter or edit the Cover Page information.

6. Click Start to send the fax.

   **Note**
   If you want to cancel the fax, click Stop.

**Redial**
If you want to redial a number, click Redial to scroll through the last five fax numbers, and then click Start.
Sending a file as a PC-FAX using the Simple style user interface

1. Create a file in Word, Excel, Paint, Draw or any other application on your PC.

2. From the File menu, select Print.
   The Print dialog box will appear:

3. Select Brother PC-FAX as your printer, and then click Print.
   The Simple style user interface will appear; if it does not check the user interface selection setting as detailed on page 5-2.

4. In the To: field, type the fax number of the recipient. You can also use the Address Book to select destination fax numbers by clicking the To: button. If you made a mistake entering a number, click the Clear button to delete all the entries.

5. To send a Cover Page and note, click the Cover Page On check box.

   Note
   You can also click the icon to create or edit a cover page.

6. When you are ready to send your fax, click the Send  icon.

7. If you want to cancel the fax, click the Cancel  icon.
Setting up PC-FAX receiving

The PC-FAX Receive function will automatically upload incoming faxes received by your machine to your PC for viewing, printing or deleting.

Note

■ Before you use the PC-FAX Receive function, you must select the option of PC-FAX Receive from the Control Panel menu on the machine. (See Setting PC Fax Rx in the User’s Guide.)
■ PC-FAX receiving is only available when using the USB/Parallel connection, not the Network (LAN) connection.

Running PC-FAX Receiving

From the Start menu, select Programs, Brother, MFL-Pro Suite MFC-XXXX (Where XXXX is your model name), and then select ‘PC-FAX Receiving’.

The PC-FAX icon will appear on your PC Task bar for this Windows® session.

Setting up your PC

1. Right-click the PC-FAX icon on your PC Task Bar, and then click PC-Fax RX Setup.
2. The PC-Fax RX Setup dialog box will appear:
3. In Save file to, use the Browse button if you want to change the path where PC-FAX files will be saved.
4. In File Format, select .tif or .max for the format the received document will be saved in. The default format is .tif.
5. If you want to, you can check the Play wave file when receiving FAX check box, and then enter the path of the wave file.
6. To load PC FAX receiving automatically when you start up Windows®, select the Add to Startup folder check box.
**Viewing new PC-FAX messages**

Each time you start to receive a PC-FAX, the icon will flash blue and red. Once the fax has been received the icon will remain red. The red icon will change to green once the received fax has been viewed. Double-click any of the new faxes to open and view them.

 profesional

**Note**

The title of your unread PC message will be the date and time until you assign a file name. For example “Fax 2-20-2002 16:40:21.tif”
Network Scanning (For Windows®)
(MFC-7225N, MFC-7820N or models with the optional NC-2200w Only)

To use the machine as a Network Scanner, the Network must be configured with a TCP/IP address that matches your network. You can set or change the settings from the control panel. (Please see the Network User's Guide on the CD-ROM.)

Network License

MFC-7225N and MFC-7820N include the PC license for up to 5 Users.
This licence supports the installation of the MFL-Pro Software Suite including ScanSoft® PaperPort® 9.0SE on up to 5 PC’s for use on a network.
If you want to use more than 5 PCs with ScanSoft® PaperPort® 9.0SE installed, please purchase NL-5 which is a multiple PC license agreement pack for up to an additional 5 Users. To purchase NL-5, please contact your Brother Sales Office.

Registering your PC with the machine for scanning

If you need to change the machine that was registered to your PC during the installation of MFL-Pro Suite (see Quick Setup Guide), follow the steps below.

1. For Windows® XP
   From the Start menu, select Control Panel, Printers and Other Hardware, Scanners and Cameras (or Control Panel, Scanners and Cameras).
   Right-click the Scanner Device icon and select properties to view the Network Scanner Properties dialog box.

For Windows® 98/Me/2000
From the Start menu, select Control Panel, Scanners and Cameras, and then right-click Scanner Device icon and select Properties to view the Network Scanner Properties dialog box.
2. Click the **Network Setting** tab in the dialog box and select a method to specify the machine as a Network scanner for your PC.

**Specify your machine by address**

Enter the IP address of the machine in the **IP Address** field. Click **Apply** and then **OK**.

**Specify your machine by Name**

Enter the machine Node name in the **Node Name** field. Click **Apply** and then **OK**.

**Search for Devices**

Click **Browse** and select the appropriate device you want to use. Click **OK**. Click **Apply** and then **OK**.

3. Click the **Scan To Button** tab in the dialog box and enter your PC name in the **Display Name** field. The machine’s LCD displays the name you enter. The default setting is your PC name. You can enter any name that you like.

**Note**

The settings in this window have no relevance when being used with the optional wireless print/scan server NC-2200w. If you followed the installation steps in the Quick Setup Guide, then the scanning destination settings have already been configured. If you need to change the settings, see the NC-2200w Network User’s Guide for details.

4. You can avoid receiving unwanted documents by setting a 4-digit Pin number. Enter your Pin number in the **Pin number** and **Retype Pin number** field. To send data to a PC protected by a Pin number, the LCD prompts to enter the Pin number before the document can be scanned and sent to the machine. (See *Using the Scan key* on page 6-3 to 6-6.)
Using the Scan key

Scan to E-mail

When you select Scan to E-mail your document will be scanned and sent directly to the PC you designated on your network. ControlCenter2.0 will activate the default E-mail application on the designated PC for addressing to the recipient. You can scan a black and white (or color document) and it will be sent with the E-mail from the PC as an attachment.

You can change the Scan configuration. (See E-mail on page 3-5.)

1. Load your document.
2. Press Scan.
3. Press ▲ or ▼ to select Scan to E-mail. Press Menu/Set.
4. Press ▲ or ▼ to select the destination PC you want to use for E-mailing your document. Press Menu/Set.
   - If the LCD prompts you to enter a Pin number, enter the 4-digit Pin number for the destination PC on the control panel.
   - Press Menu/Set.
   - The machine will start the scanning process.

Note

MFC-7225N is not able to scan color documents.
Scan to Image

When you select Scan to Image your document will be scanned and sent directly to the PC you designated on your network. ControlCenter2.0 will activate the default graphics application on the designated PC. You can change the Scan configuration. (See Image (example: Microsoft Paint) on page 3-4.)

1. Load your document.
2. Press Scan.
3. Press ▲ or ▼ to select Scan to Image. Press Menu/Set.
4. Press ▲ or ▼ to select the destination PC you want to send to. Press Menu/Set.
   - If the LCD prompts you to enter a Pin number, enter the 4-digit Pin number for the destination PC on the control panel.
   - Press Menu/Set.
   - The machine will start the scanning process.
Scan to OCR

When you select Scan to OCR your document will be scanned and sent directly to the PC you designated on your network. ControlCenter2.0 will activate ScanSoft® OmniPage® OCR and convert your document into text for viewing and editing from a word processing application on the designated PC. You can change the Scan configuration. (See OCR (Word Processing program) on page 3-5.)

1. Load your document.
2. Press **Scan**.
3. Press ▲ or ▼ to select **Scan to OCR**.
   Press **Menu/Set**.
4. Press ▲ or ▼ to select the destination PC you want to send to.
   Press **Menu/Set**.
   If the LCD prompts you to enter a Pin number, enter the 4-digit Pin number for the destination PC on the control panel.
   Press **Menu/Set**.
The machine will start the scanning process.
Scan to File

When you select Scan to File you can scan a black and white (or color document) and send it directly to a PC you designate on your network. The file will be saved in the folder and file format that you have configured in ControlCenter2.0 on the designated PC. You can change the Scan configuration. (See File on page 3-6.)

1. Load your document.

2. Press Scan.

3. Press ▲ or ▼ to select Scan to File.

   Press Menu/Set.

4. Press ▲ or ▼ to select the destination PC you want to send to.

   Press Menu/Set.

   If the LCD prompts you to enter a Pin number, enter the 4-digit Pin number for the destination PC on the control panel.

   Press Menu/Set.

   The machine will start the scanning process.

Note

- Max. 25 clients can be connected to one machine on a Network. For example, if 30 clients try to connect at a time, 5 clients will not be shown on the LCD.
- MFC-7225N is not able to scan color documents.
Setting up your USB-equipped Apple® Macintosh®

Note
Before you can connect the machine to your Macintosh®, you must buy a USB cable that is not longer than 6 feet (2 metres).

Do not connect the machine to a USB port on a keyboard or a non-powered USB hub.

The features supported by the machine will depend on the operating system you are using. The chart below shows which features are supported.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Mac OS® 9.0.X</th>
<th>Mac OS® X 10.2.4 or greater*²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Scanning (TWAIN)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ControlCenter2.0*¹</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>PC-FAX sending</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Remote Setup</td>
<td>No (not available for DCP-7020)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*¹ For details about using ControlCenter2.0, see Using ControlCenter2.0 (For Mac OS® X 10.2.4 or greater) on page 7-24.

*² For Mac OS® X 10.2.0 to 10.2.3 user, please upgrade to Mac OS® X 10.2.4 or greater. (The latest information for Mac OS® X, please visit at: http://solutions.brother.com)
Using your machine with a Macintosh®

Using the Brother printer driver with your Apple® Macintosh® (Mac OS® X)

Choosing page setup options

1. From application software such as TextEdit, click the File menu and select Page Setup. Make sure MFC-XXXX (Where XXXX is your model name) is selected in the Format for pop-up menu. You can change the settings for Paper Size, Orientation and Scale, then click OK.

2. From application software such as TextEdit, click the File menu and select Print. Click Print to start printing.
Specific settings

You can set the Media Type, Resolution, Toner Save, and other settings. Press Copies & Pages dropdown to select settings you want to change.

Print settings

Select the Quality and Media Type, and if you want to use Toner Save Mode.

Layout

Select the Pages per Sheet, Layout Direction and Border (if any).
Using your machine with a Macintosh®

Using the Brother printer driver with your Apple® Macintosh® (Mac OS® 9.1 to 9.2)

To select a Printer:

1. Open the Chooser from the Apple menu.
2. Click the Brother Laser icon. On the right side of the Chooser window, click the printer you want to print to. Close the Chooser.

To print a document:

3. From the application software such as Presto!® PageManager®, click the File menu and select Page Setup. You can change the settings for Paper Size, Orientation, and Scaling and then click OK.

4. From the application software such as Presto!® PageManager®, click the File menu and select Print. Click Print to start printing.

Note
If you want to change Copies, Pages, Resolution, Paper Source and Media Type, select your settings before clicking Print. If you click Option, you can select the number of pages per sheet in the Device Options screen. The Duplex settings are not available.
Using the PS driver with your Apple® Macintosh®
(MFC-7225N and MFC-7820N only)

Note

■ To use the PS driver on a Network, see the Network User’s Guide on CD-ROM.
■ To use the PS driver with a USB cable, you need to set the Emulation to BR-Script 3 by using the control panel before connecting the USB cable. (See Popular Printer Emulation Support (MFC-7225N and MFC-7820N only) on page 1-4.)
■ The PS driver does not support the following functions:
  • HQ 1200
  • PC-Fax Sending

For Mac OS® X users

You need to install the PS driver using the following instructions.

Note

■ If you use a USB cable and your Macintosh® is “Mac OS® X”, only one printer driver for a machine can be registered in Print Center.
■ If a Brother Native Driver (MFC-XXXX) is already listed in Printer list, you will need to delete it and then install the PS driver.

1 Select Applications from the Go menu.

2 Open the Utilities folder.
3. Open the **Printer Setup Utility** icon.
   * For Mac OS® X 10.2.X users, open the **Print Center** icon.

4. Click **Add**.

5. Select **USB**.

6. Select your model name, and then click **Add**.

7. Select **Quit Printer Setup Utility** from the **Printer Setup Utility** menu.
For Mac OS® 9.1 to 9.2 users

1. Open the **Applications (Mac OS 9)** folder.
   Open the **Utilities** folder*.
   * The screens are based on Mac OS® 9.1.

2. Open the **Desktop Printer Utility** icon.

3. Select **Printer (USB)**, and then click **OK**.

4. Click **Change...** in the PostScript™ Printer Description (PPD) file.
   Select **Brother MFC-XXXX** (Where XXXX is your model name) and then click **Select**.
5 Click **Change...** in the **USB Printer Selection**. Select **Brother MFC-XXXX** (Where XXXX is your model name), and then click **OK**.

6 Click **Create...**.

7 Enter your model name, and then click **Save**.

8 Select **Quit** from the **File** menu.

9 Click the **MFC-XXXX** icon on the Desktop.

10 Select **Set Default Printer** from the **Printing** menu.
Sending a fax from your Macintosh® application (not available for DCP-7020)

For Mac OS® X users

You can send a fax directly from a Macintosh® application.

1. Create a document in a Macintosh® application.
2. To send a fax, select **Print** from the **File** menu.
   - The Printer dialog box will appear:

3. Select **Send Fax** from the pull-down menu.
4. Select **Facsimile** from the **Output** pull-down menu.
To address the fax, type a fax number in the **Input Fax Number** box, and then click **Print**.

**Note**

If you want to send a fax to more than one number, click **Add** after entering the first fax number. The destination fax numbers will be listed in the dialog box.
Using your machine with a Macintosh®

Drag a vCard from the Mac OS® X Address Book application

You can address the fax number using a vCard (an electronic business card) from Mac OS® application to the destination fax number field.

1. Click Address Book button.
2. Drag a vCard from the Mac OS® X Address Book application to the Destination Fax Numbers field.

When you are finished addressing your fax, click Print.

Note
- The vCard used must contain a work fax or home fax number.
- When you choose work fax or home fax from the Stored Fax Numbers pull-down list, only the fax number stored in the Mac OS® X Address Book for the selected category will be used. If the fax number is stored in only one of the Mac OS® X Address Book categories, the number will be retrieved no matter which category you have selected (work or home).
For Mac OS® 9.1 to 9.2 users

You can send a fax directly from a Macintosh® application.

1. Create a document in a Macintosh® application.
2. To send a fax, select **Print** from the **File** menu.
   
   The Printer dialog box will appear:
   
   When **Printer** is selected, the top button shows **Print** and the **Address** button is grayed out.

3. From the **Output** pull-down menu, select **Facsimile**.
   
   When **Facsimile** is selected, the top button changes to **Send Fax** and the **Address** button will be available.

4. Click **Send Fax**.
   
   The **Send Fax** dialog box appears:
   
   The **Send Fax** dialog box has two list boxes. The left box shows all the previously **Stored Fax Numbers** and the right box shows the **Destination Fax Numbers** as you select them.

5. To address the fax, type a fax number in the **Input Fax Number** box.

6. When you are finished addressing your fax, click **Send Fax**.

**Note**

- To select and only send certain pages of the document, click **OK** to go to the Print dialog box.
- If you click **Send Fax** without addressing your fax, the following error message will appear:

   ![Error Message]

   Click **OK** to go to the **Send Fax** dialog box.
Using your machine with a Macintosh®

Scanning from a Macintosh®

The Brother machine software includes a TWAIN Scanner driver for Macintosh®. You can use this Macintosh® TWAIN Scanner driver with any applications that support the TWAIN specification.

>Note

If you want to scan from the machine on a network, select the networked machine in the Device Selector application located in Macintosh HD/Library/Printers/Brother/Utilities.

Accessing the scanner

Run your Macintosh® TWAIN-compliant application software. The first time you use the Brother TWAIN driver, set it as the default by choosing Select Source (or the other menu name to select the device). For each document you scan choose Acquire Image or Scan. The scanner setup dialog box will appear.

>Note

■ The screen shown in this section are from Mac OS® X 10.2. The screen on your Macintosh® may vary depending on your operating system.

■ The method of selecting the source or choosing to scan may vary depending on the application software you are using.
Using your machine with a Macintosh®

**Scanning an image into your Macintosh®**

You can scan a whole page.

—OR—

scan a portion after pre-scanning the document.

**Scanning a whole page**

1. Load your document in the ADF.

   **Note**

   If your model is a flatbed type, you can also place your document on the scanner glass.

2. Adjust the following settings, if needed, in the Scanner Setup dialog box:
   - Resolution
   - Color Type
   - Scanning Area
   - Brightness
   - Contrast

3. Click **Start**.

   When scanning has finished, the image will appear in your graphics application.
Pre-Scanning an image

Pre-Scanning allows you to scan an image quickly at a low resolution. A thumbnail version will appear in the **Scanning Area**. This is only a preview of the image, so you can see how it will look. The **PreScan** button will allow you to crop unwanted areas from the images. When you are satisfied with the preview, click **Start** to scan the image.

1. Load your document.
2. Click **PreScan**.
   
   The whole image will be scanned into your Macintosh® and will appear in the **Scanning Area** of the Scanner dialog box:

3. To scan a portion of the prescanned image, click and drag the mouse to crop it.

4. Insert the document in the ADF again.

**Note**

If your model is a flatbed type, and you loaded the document on the scanner glass in step 1, please skip this step.

5. Make your adjustments to the settings for **Resolution**, **Color Type** (Gray Scale), **Brightness**, **Contrast**, and **Size** in the Scanner Setup dialog box.

6. Click **Start**.
   
   This time only the cropped area of the document will appear in the **Scanning Area**.

7. You can refine the image in your editing software.
Settings in the Scanner window

Image

Resolution

From the Resolution pop-up menu choose the scanning resolution. Higher resolutions use more memory and transfer time, but produce a finer scanned image. The following list shows the resolution you can choose.

- 100 × 100 dpi
- 150 × 150 dpi
- 200 × 200 dpi
- 300 × 300 dpi
- 400 × 400 dpi
- 600 × 600 dpi
- 1200 × 1200 dpi
- 2400 × 2400 dpi (not available for MFC-7220 and MFC-7225N)
- 4800 × 4800 dpi (not available for MFC-7220 and MFC-7225N)
- 9600 × 9600 dpi (not available for MFC-7220 and MFC-7225N)

Color Type

Black & White—Set the image Type to Black and White for text or line art. For photographic images, set the image type to Gray (Error diffusion) or True Gray.

Gray (Error Diffusion)—is used for documents that have photographic images or graphics. (Error Diffusion is a method for creating simulated gray images without using true gray dots. Black dots are placed in a specific pattern to give the appearance of gray.)

True Gray—is used for documents with photographic images or graphics. This mode is more exact because it uses up to 256 shades of gray. It requires the most memory and takes the longest transfer time.

Colors (not available for MFC-7220 and MFC-7225N)—Choose either 8-bit Color, which scans up to 8-bit Color or 24-bit color which scans up to 16.8 million colors. Although using 24-bit color creates an image with the most accurate colors, the image file will be about three times larger than a file created with 8-bit Color.
Using your machine with a Macintosh®

**Scanning Area**
Set the Size to one of the following:

- A4 210 x 297 mm
- JIS B5 182 x 257 mm
- Letter 8.5 x 11 in
- Legal 8.5 x 14 in
- A5 148 x 210 mm
- Executive 7.25 x 10.5 in
- Business Card
- Photo 4 x 6 in
- Index Card 5 x 8 in
- Photo L 89 x 127 mm
- Photo 2L 127 x 178 mm
- Postcard 1 100 x 148 mm
- Postcard 2 148 x 200 mm
- Custom (User adjustable from 0.35 x 0.35 in. to 8.5 x 14 in or 8.9 x 8.9 mm to 215 x 355 mm.)

After you choose a custom size, you can adjust the scanning area. Click and hold the mouse button as you drag the mouse to crop the image.

- **Width:** Enter the width of the custom size.
- **Height:** Enter the height of the custom size.

**Business Card Size (not available for MFC-7220 and MFC-7225N)**

If your machine is flatbed type (not available for MFC-7220 and MFC-7225N), you can scan business cards. To scan business cards, select the Business Card size (90 x 60 mm) and place the business card at the center of scanner glass.

When you are scanning photographs or other images to use in a word processor or other graphics application, it is a good idea to try different settings for the Contrast, Mode and Resolution to determine which settings look the best.
Adjusting the Image

Brightness

Adjust the Brightness setting to get the best image. The Brother TWAIN Scanner driver offers 100 Brightness levels (-50 to 50). The default value is 0, representing an ‘average’ setting.

You can set the Brightness level by dragging the slide bar to the right to lighten the image or to the left to darken the image. You can also type a value in the box to set the level. Click OK.

If the scanned image is too light, set a lower Brightness level and scan the image again.

If the image is too dark, set a higher Brightness level and scan the image again.

Note

The Brightness setting is only available when Black & White or Gray (Error Diffusion) or True Gray is selected.

Contrast

You can only adjust the Contrast level when you have selected one of the Gray Scale settings, it is not available when you have selected Black & White as the selected Color Type.

Increasing the Contrast level (by dragging the slide bar to the right) emphasizes dark and light areas of the image, while reducing the Contrast level (by dragging the slide bar to the left) reveals more detail in the gray areas. Instead of using the slide bar, you can type a value in the box to set the Contrast. Click OK.
Configuring Network Scanning

(MFC-7225N and MFC-7820N or models with the optional NC-2200w only)

If you want to scan from the machine on a network, you must select the networked machine in the Device Selector application located in Macintosh HD/Library/Printers/Brother/Utilities. If you already installed the MFL-Pro Software following the network installation steps in the Quick Setup Guide then this selection should already be made.

To use the machine as a Network Scanner, the machine must be configured with a TCP/IP address. You can set or change the address settings from the control panel. (Please see the Network User’s Guide on the CD-ROM.)

**Note**

Max. 25 clients can be connected to one machine on a Network. For example, if 30 clients try to connect at a time, 5 clients will not be shown on the LCD.

(The ControlCenter2.0 is available for Mac OS® 10.2.4 or greater only.)

1. From **Library**, select **Printers**, **Brother**, **Utilities** and **DeviceSelector**, and then doubleclick **DeviceSelector**.

   The **DeviceSelector** window appears. This window can also be opened from the ControlCenter2.0.

2. Select **Network** from the connection type pull-down menu.

   ![DeviceSelector Window](image)

3. Specify your machine by IP Address or Node Name. To change the IP address, enter the new IP address. To change the Node Name of your machine, enter the new node name. Each node (machine) has its own node name. You can find the node name by printing out the machine configuration page. (Please see the Network User’s Guide on the CD-ROM.) The default Node Name is “BRN_xxxxxx” (“xxxxxx” is the last six digits of Ethernet address.)

   You can also select a machine from the list of the machines available. Click **Browse** to show the list.

4. Click the **OK** button.
Using your machine with a Macintosh®

Using the Scan Key

For Network users, see Using the Scan key on page 6-3.
For USB users, see Using the Scan key (For USB or Parallel cable users) on page 2-13.

Note

- Turn on Register your computer with the “Scan To” functions at the machine and enter a 4 digit PIN number.
- You can avoid receiving unwanted documents by setting a 4-digit Pin number. Enter your Pin number in the Pin number and Retype Pin number field. To send data to a computer protected by a Pin number, the LCD prompts to enter the Pin number before the document can be scanned and sent to the machine. (See Using the Scan key on page 6-3 to 6-6.)
Using Presto!® PageManager®

Presto!® PageManager® is application software for managing the documents in your computer. Since it is compatible with most image editors and word processing programs, Presto!® PageManager® gives you unmatched control over your computer files. You can easily manage your documents, edit your E-mail and files and read documents with the OCR software built into Presto!® PageManager®.

If you use the machine as a scanner, we recommend that you install Presto!® PageManager®. To install Presto!® PageManager®, see the Quick Setup Guide.

Note

The complete NewSoft Presto!® PageManager® 4.0 User’s Guide can be viewed from the Help icon in NewSoft Presto!® PageManager® 4.0.

Highlights

- OCR: In one step you can scan an image, recognize the text, and edit it with a word processor.
- Image Editing: Enhance, crop and rotate images, or open them with an image-editing program of your choice.
- Annotation: Add removable notes, stamps and drawings to images.
- Treeview Window: View and arrange your folder hierarchy for easy access.
- Thumbnail Window: View files as thumbnails for easy identification.

System requirements for Presto!® PageManager®

- PowerPC processor
- Mac OS® 9.1 - 9.2, Mac OS® X 10.2.4 or greater
- CD-ROM drive
- Hard disk drive with at least 120 MB of free disk space

Recommended:

- 8-bit Color or higher video adapter.
- Eudora Mail, or Outlook Express electronic mail software
Using your machine with a Macintosh®

Technical Support

[For USA]
Company name: Newsoft America Inc.
Postal Address: 4113 Clipper Court Fremont
CA 94538, USA
Telephone: 510-4458600
Fax: 510-4458601
E-mail Address: contactus@newsoftinc.com
URL: http://www.newsoft.com/

[For Canada]
E-mail Address: contactus@newsoftinc.com

[Germany]
Company name: NewSoft Europe
Postal Address: Regus Center Fleethof Stadthausbrucke 3
20355 Hamburg, Germany
Telephone: 49-40-37644530
Fax: 49-40-37644500
E-mail Address: contact@newsoft.eu.com
URL: http://de.newsoft.eu.com/

Company name: SoftBay GmbH
Postal Address: Carlstrasse 50
D-52531 Ubach-Palenberg
Telephone: 49(0)2451/9112647
Fax: 49(0)2451/409642
E-mail Address: newsoft@softbay.de
URL: http://de.newsoft.eu.com/

[UK]
Company name: Guildsoft Ltd
Postal Address: Not Available
Telephone: 44-01752-201148
Fax: 44-01752-894833
E-mail Address: Tech@guildsoft.co.uk
URL: http://uk.newsoft.eu.com/
### France
- **Company name:** Partners in Europe
- **Postal Address:** Unit 14, Distribution Centre, Shannon Ind. Est Shannon, Co. Clare, Ireland
- **Telephone:** 0800-917171
- **E-mail Address:** Newsoft@pie.ie

### Italy
- **Company name:** V.I.P
- **Postal Address:** Not Available
- **Telephone:** 166821700
- **Fax:** 532786999
- **E-mail Address:** supporto@gensoforonline.com

### Spain
- **Company name:** Atlantic Devices
- **Postal Address:** Caputxins, 58, 08700 Igualada
- **Telephone:** 938040702-33
- **Fax:** 938054057
- **E-mail Address:** support@atlanticdevices.com

### Other countries
- **E-mail Address:** tech@newsoft.eu.com
Using ControlCenter2.0 (For Mac OS® X 10.2.4 or greater)

ControlCenter2.0 is a software utility that allows you to quickly and easily access the most frequently used applications. Using ControlCenter2.0 eliminates the need to manually launch the specific applications. ControlCenter2.0 provides the following five categories of operations:

1. Scan directly to a file, E-mail, word processor or graphics application of your choice.
2. Custom Scan buttons allow you to configure a button to meet your own application requirements.
3. Access the Copy features available via your Macintosh®.
4. Access the settings available to configure your device. (not available for DCP-7020)

Note
The functions that can be used in ControlCenter2.0 may vary depending upon the model.

You can open the configuration window for each function by clicking the Configuration button. Also you can select which machine will connect with ControlCenter2.0 from the Model pull-down list.

How to turn off the AutoLoad feature in ControlCenter2.0

The icon will appear on the menu bar. To open the ControlCenter2.0 window, click on the icon  and select Open.

If you do not want ControlCenter2.0 to run automatically each time the computer is started;

1. Click on the ControlCenter2.0 icon in the menu bar and select Preference.

2. The ControlCenter2.0 preference window appears, then uncheck the Start ControlCenter on computer startup check box.

3. Click OK to close the window.

Note
The ControlCenter2.0 application icon is in Macintosh HD/Library/Printers/Brother/Utilities/ControlCenter.
This section contains four buttons for **Scan to Image**, **Scan to OCR**, **Scan to E-mail** and **Scan to File** applications.

- **Image** *(Default: Apple PreView)* — enables you to scan a page directly into any graphic viewer/editor application. You can select the destination application, such as Adobe® PhotoShop® or any kind of image editing application you already have installed on your computer.

- **OCR** *(Default: Apple Text Edit)* — enables you to scan a page or document, automatically run the OCR application and insert the text (not a graphic image) into a word processing application. You have the option of selecting the target word processing application, such as MS Word or whichever word processing application is installed on your computer.

- **E-mail** *(Default: your default E-mail software)* — enables you to scan a page or document directly into an E-mail application as a standard attachment. You have the option of selecting the file type and resolution for the attachment.

- **File** — enables you to scan directly to a disk file. You can change the file type and destination folder, as needed.

The ControlCenter2.0 gives you the ability to configure the hardware **Scan** key on your machine for each scan feature. Select the **Device Button** in the configuration menu for each of the **SCAN** buttons.

**Note**

For details about how to use the **Scan** key, see *Using the Scan key (For USB or Parallel cable users)* on page 2-13.

**CUSTOM SCAN**

You can configure the button name and settings for each of these buttons to meet your specific requirements by clicking on a button while holding down the Ctrl key and following the configuration menus.

**COPY**

**COPY** — allows you to use the PC and any printer driver for enhanced copy operations. You can scan the page on the machine and print the copies using any of the features of the machine printer driver—**OR**—you can direct the copy output to any standard printer driver installed on the PC including network printers.

You can configure your preferred settings on up to four buttons.
DEVICE SETTINGS (not available for DCP-7020)

You can configure the machine settings.

- **Remote Setup** — enables you to open the Remote Setup Program. (See *MFC Remote Setup (Mac OS® X 10.2.4 or greater) (not available for DCP-7020)* on page 7-36.)

- **Quick-Dial** — enables you to open the Set Quick-Dial window of the Remote Setup. (See *MFC Remote Setup (Mac OS® X 10.2.4 or greater) (not available for DCP-7020)* on page 7-36.)

**Note**

When the machine is connected to a network, you cannot use these functions.

SCAN

This section contains four buttons for **Scan to Image**, **Scan to OCR**, **Scan to E-mail** and **Scan to File** applications.

These four selections can be accessed from ControlCenter2.0 or from the Scan key on the control panel of the machine. The Target Application, File Type and scan settings are configured independently by choosing the Software Button or Device Button tabs of the ControlCenter2.0 Configuration window.

Image (example: Apple PreView)

**Scan to Image** feature allows you to scan an image directly into your graphics application for image editing. To change the default settings, click on the button while holding down the Ctrl key and select Software Button or Device Button.
Using your machine with a Macintosh®

To change the destination application, select the appropriate application from the **Target Application** pull down list. You can add an application to the lists by clicking the **Add** button.

Enter the **Application Name** (up to 30 characters) and select your preferable application by clicking the **Browse** button. Also choose the **File Type** from the pull-down list.

You can delete application that you have added. Just select the **Application Name** and click the **Delete** button.

**Note**

This function is also available for Scan to E-mail and Scan to OCR. The window may vary depending upon the function.

**OCR (Word Processing program)**

**Scan to OCR** converts the graphic page image data into text which can be edited by any word processor program. You can change the default word processor program.

To configure **Scan to OCR**, click on the button while holding down the Ctrl key and select **Software Button** or **Device Button**.

To change the word processing application, select the destination word processing application from the **Target Application** pull down list. You can add an application to the lists by clicking the **Add** button. An application can be deleted by clicking on the **Delete** button.

You can also configure the other settings for this selection.
Using your machine with a Macintosh®

E-mail

Scan to E-mail feature allows you to scan a document to your default E-mail application, so you can send the scanned job as an attachment. To change the default E-mail application or attachment file type, click on the button while holding down the Ctrl key and select Software Button or Device Button.

To change the E-mail application, select your preferred E-mail application from the E-mail Application pull down list. You can add an application to the lists by clicking the Add button. An application can be deleted by clicking on the Delete button.

You can also change the other settings used to create the file attachments.

File attachments

You can choose from the following list of file types for attachment to your E-mail or for saving to a folder.

File type — Select from the pull-down list the type of file you want the scanned images to be saved in.

- Windows Bitmap (*.bmp)
- JPEG (*.jpg)
- TIFF - Uncompressed (*.tif)
- TIFF - Compressed (*.tif)
- TIFF Multi-Page - Uncompressed (*.tif)
- TIFF Multi-Page - Compressed (*.tif)
- Portable Network Graphics (*.png)
- PDF (*.pdf)

Note

Additional file format support is available by scanning to Presto!® PageManager® and then use the save as function and choose the file format. (See Using Presto!® PageManager® on page 7-21.)

The additional file types supported are:

- TIFF - Group 4 (*.tif)
- TIFF - Class F (*.tif)
- TIFF Multi Page - Group 4 (*.tif)
- TIFF Multi Page - Class F (*.tif)
File

Scan to File button allows you to scan an image and save it in a specific file type to any directory on your hard disk. This allows you to easily archive your paper documents. To configure the file type and save to directory, click on the button while holding down the Ctrl key and select Software Button or Device Button.

Select the file type for the saved image by selecting from the File Type pull down list. You can save the file to the default Pictures folder, or you can select another folder/directory by clicking the Browse button.

Note

For the supported file types, please refer to the File attachments on page 7-28.

CUSTOM SCAN

There are four buttons from which you can set your own preferences and configuration to fit your required usage for scanning.

To configure a button, click on the button while holding down the Ctrl key, and the configuration window will appear. You have four function choices of scan action, Scan to Image, Scan to OCR, Scan to E-mail and Scan to File.

Scan to Image: This setting allows you to scan a page directly into any graphic viewer/editor software. You can select any kind of image editor application you have installed on your computer as a destination application.

Scan to OCR: Scanned documents will be converted to editable text files. If you have a third party OCR software package installed on your computer, you can select it. You can also select the destination application for the editable text.

Scan to E-mail: Scanned images will be attached to an E-mail message. You can choose which E-mail application to use if you have more than one installed on your system. You can also select the file type for the attachment and create a quick send list of E-mail addresses chosen from your default E-mail address book.

Scan to File: This setting allows you to save a scanned image to any directory on a local or network hard disk. You can also select the file type to be used.

Customizing a user-defined button

To configure a button, click on the button while holding down the Ctrl key, and the configuration window will appear. Please follow the following guide lines for the button configuration.
Scan to Image:

In General tab
You can enter up to a 30 character name in the Name for Custom field. This name will appear as the button name. Select the type of scan from the Scan Action field.

In Settings tab
You can select Target Application, File Type, Resolution, Scan Type, Document Size, Brightness and Contrast settings.
Scan to OCR:

In the **General** tab
You can enter up to a 30 character name in the **Name for Custom** field. This name will appear as the button name.
Select the type of scan from the **Scan Action** field.

In the **Settings** tab
You can select **Target Application**, **File Type**, **OCR Software**, **Resolution**, **Scan Type**, **Document Size**, **Brightness** and **Contrast** settings.
Using your machine with a Macintosh®

**Scan to E-mail:**

In the **General** tab
You can enter up to a 30 character name in the **Name for Custom** field. This name will appear as the button name.
Select the type of scan from the **Scan Action** field.

In the **Settings** tab
You can select **E-mail Application**, **File Type**, **Resolution**, **Scan Type**, **Document Size**, **Brightness** and **Contrast** settings.
Scan to File:
In the General tab
You can enter up to a 30 character name in the Name for Custom field. This name will appear as the button name.
Select the type of scan from the Scan Action field.

In the Settings tab
Select the file format from the File Type pull down list. You can either send the file to the default My pictures folder or select your own destination folder by using the Browse button.
You can also select Resolution, Scan Type, Document Size, Brightness and Contrast settings.
COPY

The Copy buttons (1-4) can be customized to allow you to take advantage of the features built into the Brother printer drivers to do advanced copy functions such as N-in-1 printing.

Before you can use the Copy buttons you must first configure the printer driver by clicking on the button while holding down the Ctrl key.

You can enter up to a 30 character name in the Name for Copy field and select Copy Ratio.

You can select the Resolution, Scan Type, Document Size, Brightness and Contrast settings to be used.

Before finishing the Copy button configuration, you must set the Printer Name. Then select your print settings from the Presets pull-down list, then click OK to close the window. By clicking the configured copy button, the print dialog window will open.

Note

- You must configure each of the copy buttons before they can be used.
- Using the Copy button, you can also send a fax using the printer driver. (See Sending a fax from your Macintosh® application (not available for DCP-7020) on page 7-9)
DEVICE SETTINGS (not available for DCP-7020)

In this section you can configure the machine settings by clicking the button.

Note
When the machine is connected to a network, you cannot use these functions.

Remote Setup
The Remote Setup button allows you to open the Remote Setup Program window with which you can configure the machine setting menus.

Quick-Dial
The Quick-Dial button allows you to open the Set Quick-Dial window of the Remote Setup Program, so you can easily register or change the dial numbers from your computer.
MFC Remote Setup (Mac OS® X 10.2.4 or greater) (not available for DCP-7020)

The MFC Remote Setup application enables you to configure many MFC settings from a Macintosh® application. When you access this application, the settings on your machine will be downloaded automatically to your Macintosh® and displayed on your computer screen. If you change the settings, you can upload them directly to the machine.

Note
The ‘MFC Remote Setup’ application icon is in Macintosh HD/Library/Printers/Brother/Utilities.

OK
This starts the process of uploading the data to the machine and exiting the remote setup program. If an error message is displayed enter the correct data again. Click OK.

Cancel
This exits the remote setup application without uploading the data to the machine.

Apply
This uploads the data to the machine, but does not exit the remote setup application.

Print
This command prints the selected items on the machine. You cannot print the data until it is uploaded to the machine. Click Apply to upload the new data to the machine and click Print.

Export
This command saves the current configuration settings to a file.

Import
This command reads the settings from a file.
# Index

## C
- ControlCenter2.0  
  Windows® .................................................. 3-1

## D
- Drivers  
  Macintosh®  
    printer ................................................. 7-2, 7-4  
    PS ....................................................... 7-5  
    TWAIN .................................................. 7-13  
  Windows®  
    printer .................................................. 1-1, 1-6  
    TWAIN .................................................. 2-1, 2-7  
    WIA ...................................................... 2-2
- drivers  
  Windows®  
    printer .................................................. 1-1

## E
- Emulation  
  Macintosh® ................................................ 7-5  
  Windows® PCL and PS .................................... 1-4

## F
- Fax  
  Macintosh®  
    PC-FAX (Mac OS® 9.1 - 9.2) ....................... 7-12  
    PC-FAX (Mac OS® X) ................................. 7-9, 7-11  
  Windows®  
    PC-FAX ................................................ 5-1

## M
- MFC Remote Setup  
  Macintosh® (Mac OS® X) ......................... 7-36  
  Windows® ................................................ 4-1

## P
- PaperPort® (Windows®)  
  exporting ................................................. 2-18  
  importing ............................................... 2-17  
  PaperPort® 9.0SE (Windows®) and OmniPage® OCR  
  PC-FAX (Macintosh®) .................................... 7-9  
  PC-FAX (Windows®) ...................................... 5-1
- sending  
  address book ........................................... 5-6  
  cover page .............................................. 5-5  
  facsimile style ......................................... 5-10  
  group ...................................................... 5-7  
  simple style ............................................ 5-11
- Print  
  Emulation  
    Macintosh® ............................................. 7-5  
    Windows® ................................................ 1-4  
    Macintosh®  
      Brother driver .................................... 7-2, 7-4  
    reports and lists ................................... 1-4  
    Windows®  
      driver settings ...................................... 1-6  
      keys on control panel ............................ 1-3  
      printer driver ...................................... 1-1, 1-18  
      PS printer driver .................................. 1-18

## S
- Scan  
  Macintosh®  
    Scan key .............................................. 2-13  
    TWAIN ................................................... 7-13  
  Windows®  
    OmniPage® OCR ...................................... 2-17  
    Resolution .......................................... 2-10  
    Scan key .............................................. 2-13, 6-3  
    TWAIN Compliant .................................... 2-7  
    WIA Compliant ....................................... 2-2  
    Status Monitor (Windows® only) .................. 1-20
These machines are made for use in the USA and CANADA only. We cannot recommend using them overseas because it may violate the Telecommunications Regulations of that country and the power requirements of your multi-function center may not be compatible with the power available in foreign countries. Using USA or CANADA models overseas is at your own risk and may void your warranty.